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1 Introduction

1.1 About this manual
This manual provides information on how to set and configure the device
parameters of a netX based EtherCAT Master device using the EtherCAT
Master DTM, and what can be read from the diagnosis panes.

Refer to the operating instruction manual “netDevice and
netProject” how to create a network configuration, or to the
operating instruction manual for the generic DTM, for EtherCAT
Slave devices, how to configure the EtherCAT Slave device.

Error codes

All status and error codes you find in the API manual "Hilscher
status and error codes".

1.1.1 Online help
The EtherCAT Master DTM contains an integrated online help.
Ø To open the online help, click on Help or press F1.

1.1.2 List of revisions
Index Date Version Component Changes
11 2022-06-27 1.1100 ECATMasterDTM.dll,

ECATMasterGUI.ocx
Document revised.
Chapter Error codes removed. See API Manual
"Hilscher status and error codes" instead.

12 2023-06-27 1.1100 ECATMasterDTM.dll,
ECATMasterGUI.ocx

Section Access to online functions [} page 19]
added.
Section Process data handshake [} page 60]
revised.
Sections Object dictionary [} page 124] and
EtherCAT terminology [} page 131] added.

Table 1: List of revisions
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1.2 Overview use cases
In the table below you find an overview of the applicable use cases.

Use case Description Chapter, section
Device start up · Creating project configuration

· Start/stop communication

Device start up [} page 15]
Create project configuration [} page 18]
Start/stop communication [} page 20]

Driver and device
assignment settings

· Verifying or adapting driver settings
· Configuring drivers
· Assigning device (with or without

firmware)
· Selecting and downloading firmware

Verifying or adapting driver
settings [} page 22]
Configuring drivers [} page 24]
Assigning device (with or without
firmware) [} page 31]
Selecting and downloading
firmware [} page 36]

Licensing (licenses for master protocols) Licensing [} page 43]
Configuring device
parameters

· General settings
· Select process data handshake

method
· Emulate topology
· Configure mailbox
· Set parameters for FMMU/SyncMan
· Set process data
· Set device address
· Init commands

General [} page 57]
Process data handshake [} page 60]
Topology [} page 60]
Mailbox [} page 67]
FMMU/Sync Man [} page 74]
Process data [} page 77]
Address table [} page 79]
Init commands [} page 81]

Connecting/disconnecting
device

Establishing online connection Connecting/disconnecting device [} page 84]

Downloading configuration Download to the device Download configuration [} page 86]
Importing network structure Identifying network configuration

automatically.
Network scan [} page 88]

Online comparison Compare configured devices and
network scan result

Online comparison [} page 96]

Diagnosis · General diagnosis
· Master diagnosis
· Station diagnosis
· Firmware diagnosis

Overview diagnosis [} page 99]
General diagnosis [} page 100]
Master diagnosis [} page 102]
Station diagnosis [} page 103]
Firmware diagnosis [} page 104]

Extended diagnosis Finding communication/configuration
errors.

Extended diagnosis [} page 105]

Packet Monitor Test of send and receive data. Packet monitor [} page 116]
IO Monitor Test of communication. I/O monitor [} page 119]
Process Image Monitor Display fieldbus structure and data

structure of the input and output data of
the devices transmitted on the bus.

Process image monitor [} page 120]

User rights Definition of access rights User rights [} page 123]
Table 2: Overview use cases
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1.3 About the EtherCAT Master DTM
The EtherCAT Master DTM is used to configure an EtherCAT Master
device. The configuration is done using the FDT frame application
SYCON.net, which serves as configuration software.

1.4 Requirements EtherCAT Master DTM
To configure the an EtherCAT Master device with the EtherCAT Master
DTM the following requirements have to be accomplished:
· Completed hardware installation of a netX based DTM-compatible

EtherCAT Master device, including loaded firmware, license and loaded
configuration file

· Installed FDT/DTM frame application (V1.2 compliant)
· Loaded DTM in the device catalog of the FDT framework

Note:
If the EtherCAT Master DTM and the EtherCAT Master device are
installed on the same PC, the cifX device driver must be installed
on that PC, as you can connect the DTM to the device.

For more information to the hardware installation, please refer to the
corresponding User Manual of your device. Information on how to
order and to download the license to the device, you will find in this
manual in the sections about the use case "Licensing".
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1.5 System requirements
· PC with 1 GHz processor or higher
· Windows® XP SP3,

Windows® Vista (32-bit) SP2,
Windows® 7 (32-bit and 64-bit) SP1,
Windows® 8 (32-bit and 64-bit),
Windows® 8.1 (32-bit and 64-bit),
Windows® 10 (32-bit and 64-bit)

· Administrator privilege required for installation
· Internet Explorer 5.5 or higher
· RAM: min. 512 Mbyte, recommended 1024 Mbyte
· Graphic resolution: min. 1024 x 768 pixels
· Keyboard and mouse
· Restriction: Touch screen is not supported.

Note:
If the project file is used on a further PC,
- this PC must also comply with the above system requirements,
- the device description files of the devices used in the project must
be imported into the configuration software SYCON.net on the new
PC,
- and the DTMs of the devices used in the project must also be
installed on that further PC.
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1.6 DTM dialog structure
The graphical user interface of the DTM is composed of different areas and
elements listed hereafter:
1. A header area containing the General device information,
2. the Navigation area (area on the left side),
3. The Dialog pane (main area on the right side),
4. OK, Cancel, Apply, Help,
5. The Status line containing information e. g. the online-state of the

DTM.

Figure 1: Dialog structure of the Device Type Manager

1.6.1 General device information
Parameter Description
IO device Device name
Vendor Vendor name of he device
Device ID Identification number of the device
Vendor ID Identification number of the vendor

Table 3: General device information
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1.6.2 Navigation area
In the navigation area, you can select the individual dialog panes via the
folder structure of the DTM.

Figure 2: Navigation area

Ø Select the required folder and subfolder.
ð The corresponding dialog pane appears.
Ø Click , to hide or to open the navigation area.

1.6.3 Dialog pane
In the dialog pane area, the different windows of the DTM appear only with
displayed information or for required setting steps. You call up the
respective windows via the associated folder in the navigation area.

1.6.4 OK, Cancel, Apply, Help,
In the configuration software SYCON.net the following is valid:

Description
OK To confirm your latest settings, click OK.

All changed values will be applied on the frame application database. The dialog then closes.
Cancel To cancel your latest changes, click Cancel.

Answer to the safety query "Configuration data has been changed. Do you want to save the data?" by
Yes, No or Cancel.
· Yes: The changes are saved or the changed values are applied on the frame application database.

The dialog then closes.
· No: The changes are not saved or the changed values are not applied on the frame application

database. The dialog then closes.

· Cancel: Back to the DTM.
Apply To confirm your latest settings, click Apply.

All changed values will be applied on the frame application database. The dialog remains opened.
Help To open the DTM online help, click Help.

Table 4: OK, Cancel, Apply, Help
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1.6.5 Status bar
In the status bar, graphical icons display the current DTM state (e. g.,
connection or download status, or other activities).

Figure 3: Status bar – status fields 1 to 6

Status 
field

Icon / description

1 DTM connection states
Connected: Icon closed = Device is online

Disconnected: Icon opened = Device is offline

2 Data source states
Data set: The displayed data is read out from the instance data set
(database).

Device: The displayed data is read out from the device.

3 States of the instance date set
Valid Modified: Parameter is changed (not equal to data source).

4 Changes directly made on the Device
Load/configure diagnosis parameters: Diagnosis is activated.

6 Device diagnosis status
Save operation succeeded: The save operation has been successful.
Further messages due to successful handling of device data.
Firmware Download: Firmware download is running

Save operation failed: The save operation has failed.
Further fail operation messages due to incorrect communication due to
malfunction in the field device or its peripherals.

Table 5: Status bar icons [1]

Offline state

Save operation
succeeded
Firmware download

Firmware download
successful
Online state and
diagnosis

Table 6: Status bar, display examples
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2 Safety

2.1 General note
The documentation in the form of a user manual, an operating instruction
manual or other manual types, as well as the accompanying texts, have
been created for the use of the products by qualified personnel. When
using the products, all Safety Messages, Integrated Safety Messages,
Property Damage Messages and all valid legal regulations must be obeyed.
Technical knowledge is presumed. The user has to assure that all legal
regulations are obeyed.

2.2 Intended use
The EtherCAT Master DTM serves for configuration and diagnosis of
EtherCAT Master devices.

2.3 Personnel qualification
Personnel responsible for the application of the network system shall be
aware of the system behavior and shall be trained in using the system.
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2.4 Safety messages

2.4.1 Communication stop caused by firmware or configuration download
If you want to perform either a firmware update (as a download) or a
configuration download, both via the EtherCAT Master DTM, please be
aware of the following:
· Together with the firmware download, an automated reset to the device

is performed that will interrupt all network communication and all
established connections will drop.

· If you download the firmware or the configuration during bus operation,
the communication between master and slaves stops and a plant stop
may occur.

Possible faulty system operation
· Unpredictable and unexpected behavior of machines and plant

components due to a plant stop may result in personal injury and
damage to your equipment.

Ø Stop the application program, before starting the firmware update or
before downloading the configuration.

Ø Make sure that your equipment operates under conditions that prevent
personal injury or property damage. All network devices should be
placed in a fail-safe mode, before starting the firmware update or before
downloading a configuration.

Loss of device parameters, overwriting of firmware
· A communication stop can cause device parameters to be lost and

damage to the device.
· Both the firmware download and the configuration download erase the

configuration database. The firmware download overwrites the existing
firmware in the network device.

Ø To complete the firmware update and to make the device operable
again, re-load the configuration after the firmware update has been
finished.

Device parameters that have been saved volatile, e. g. as the temporarily
set IP address parameters, are getting lost during the reset.
· In order to prevent loss of configuration data, make sure that your

project configuration data are saved non-volatile, before you initiate a
firmware update or download the configuration.

Ø In order to prevent loss of configuration data, before you initiate a
firmware update or download the configuration, make sure that your
project configuration data are saved non-volatile.

2.4.2 Mismatching system configuration
Mismatching system configuration loaded into the device may result in
faulty data mapping in the application program. Thus, unexpected
equipment operation may cause personal injury or damage to equipment.
Ø In the device, use only a configuration suitable for the system.
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2.5 Property damage

2.5.1 Power disconnect during firmware or configuration download
If during the process of downloading a firmware or configuration,
· the power supply to a PC with the software application is interrupted,
· or the power supply to the EtherCAT Master device is interrupted,
· or a reset to the device is done.

This may lead to the following consequences:

Loss of device parameters, firmware corruption
· The firmware download or the configuration download is interrupted and

remains incomplete.
· The firmware or the configuration database will be corrupted and device

parameters will be lost.
· Damage to the device may occur, as the device cannot be rebooted.

Whether these consequences occur depends on when the power
disconnect occurs during the download.
Ø During firmware or configuration download process, do not interrupt the

power supply to the PC or to the device, and do not perform a reset!

Otherwise, you might be forced to send in your device for repair.

Power drop during write and delete accesses in the file system

The FAT file system in the netX firmware is subject to certain limitations in
its operation. Write and delete accesses in the file system (firmware
update, configuration download etc.) can destroy the FAT (File Allocation
Table) if the accesses cannot be completed if the power drops. Without a
proper FAT, a firmware may not be found and cannot be started.

Make sure that the power supply to the device is not interrupted during
write and delete accesses in the file system (firmware update, configuration
download, etc.).

2.5.2 Invalid firmware
Loading invalid firmware files could render your module unusable.
Ø Only load firmware files to the device that are valid for this device.

Otherwise, you might be forced to send in your device for repair.
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3 Device start up

3.1 Configuration steps
The following overview provides to you the step sequence on how to
configure a netX based EtherCAT Master device with EtherCAT Master
DTM as it is typical for many cases. It is assumed at this point that the
hardware installation has been completed.

Step Brief description Further information
Add EtherCAT Slave in the
device catalog

Open configuration software SYCON.net.
Add device by importing the device description file to the
Device Catalog.
- Network > Import device descriptions.

Section Create project
configuration [} page 18], or
Operating instruction manual
“SYCON.net” and Operating
instruction manual “netDevice
and netProject”

Load device catalog - Select Network > Device catalog,
- Reload catalog.

Create / open project - Select File > New or File > Open.
Insert the master device
and the slave device and
into configuration

- In the Device catalog, select the master device and
insert the device via drag & drop to the line in the
network view.
- In the Device catalog, select the slave device and
insert the device via drag and drop to the master bus
line in the network view.*
*This step will not be necessary if the network structure
is scanned automatically.

Open master DTM
configuration dialog

- Double click to the device icon of the master.
- The DTM configuration dialog is displayed.

-

Verify or adapt driver
settings

- Select Settings > Driver.
Note! For PC cards cifX the cifX device driver is preset
as a default driver. For all the other Hilscher devices, the
netX driver is preset as a default driver.
· Use the cifX device driver if the EtherCAT Master

DTM is installed on the same PC as the EtherCAT
Master device.

· Use the netX driver to establish a USB, Serial
(RS232) or TCP/IP connection from the EtherCAT
Master DTM to the EtherCAT Master device.

· The 3Sgateway driver for netX (V3.x) is used only in
relationship with CODESYS.

To search for devices you can check one or multiple
drivers simultaneously.
- Verify that the default driver is checked.
- If necessary, check another driver or multiple drivers.

Section Verifying or adapting
driver settings [} page 22]
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Step Brief description Further information
Configure driver If you use the netX driver, you respectively must

configure it.
For netX Driver and communication via TCP/IP set
the IP adress of the device.
- Select Settings > Driver > netX driver > TCP
connection.

- Via  add an IP range.
- Under IP address enter the IP Address of the device
or an IP range.
- Click Save.
Adjust the driver parameters netX driver USB/RS232
only if they differ from the default settings.
Note!
· The cifX device driver requires no configuration.
· The configuration of the 3Sgateway driver for netX

(V3.x) is carried out via the CODESYS user interface.

Configuring netX
driver [} page 25]

Assign master device to
the driver (with or without
firmware)

- Select Settings > Device assignment.
- Under Device selection, select suitable only or all and
click Scan.
- In the table, check the required devices.
- Click Apply.

Assigning device (with or without
firmware) [} page 31]

Select and download
firmware

If not yet a firmware was loaded to the device:
- Adhere to the necessary safety precautions to prevent
personnel injury and property damage.
- Select Settings > Firmware download,
- clock Browse..,
- select a firmware file,
- click Open.
- Click Download and Yes.

For further details, please refer
to the Safety chapter.

Selecting and downloading
firmware [} page 36]

Assign master device once
more (with firmware and
system channel)
For repeated download this
step is omitted.

- Select Settings > Device assignment,
- click Scan,
- In the table, check the required device.
- Click Apply.

Selecting the device once more
(with firmware) [} page 34]

Configure slave device*
(*This step will not be
necessary if the network
structure is scanned
automatically.)

- In the slave DTM dialog select Configuration >
Behavior.
- Set the Watchdog control and Interval. 
- Set the timeout values for various state machine
transitions. 
- Specify which verifications to perform during device
check-up.
- Choose between combined and separate EtherCAT
commands for read and write accesses.
- Select Process data.
- Configure the process data of the slave (PDO
assignment and PDO contents).
- Close the dialog via OK.

Operating instruction manual
“Generic DTM for EtherCAT
Slave devices”
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Step Brief description Further information
Configure master device - In the master DTM configuration dialog, select

Configuration.
- Select Process data handshake.
- Set the process data handshake procedure.
- Select Topology.
- In the graphical editor, recreate the current network
topology according to the requirements. To do this, use
the connection view.
- Select Mailbox.
- For slaves with configurable CoE parameters, make
entries on the 'Start-up' and 'Userdef Start-up' tabs.
- Select FMMU/ SyncMan.
- Set the parameters for FMMU and for the Sync
manager.
- Select Process data.
- Assign symbolic names for the configured modules or
measuring signals. 
- Select Address table.
- Set the address information and parameters for the
process data objects (PDO).
- Select Init Commands.
- Edit the table of Init commands according to the
requirements. 
- Close the dialog via OK.

General [} page 57]
Process data
handshake [} page 60]
Topology [} page 60]
Mailbox [} page 67]
FMMU/Sync Man [} page 74]
Process data [} page 77]
Address table [} page 79]
Init commands [} page 81]

Save project - Select File > Save. Operating instruction manual
“SYCON.net”

Connect master device - Right click to the device icon of the master,
- Select Connect.

Section Connecting/
disconnecting
device [} page 84]

Download configuration - Adhere to the necessary safety precautions to prevent
personnel injury and property damage that may occur in
consequence of a communication stop or in
consequence of a mismatching system configuration.
- Right click to the device icon of the master,
- Select Download.

Section Download
configuration [} page 86]

Network scan Alternative to manual configuration of the slave device,
you can scan the network structure (in the master DTM).
Proceed as follows:
1. Click Network scan.
2. Make the settings in the Scan response dialog.
3. Click Create devices.
4. Download the current slave device configuration to
the master device.

Section Network
scan [} page 88]

Diagnosis - Right click to the device icon of the master.
- Select Diagnosis.
- The diagnosis dialog appears.
(1.) Check whether the communication is OK:
Diagnosis > General diagnosis > Device status
“Communication” must be green!
(2.) “Communication” is green: Open the IO monitor
and test the input or output data. 
(3.) “Communication” is not green: Use diagnosis and
extended diagnosis for troubleshooting.
- Close the dialog via OK.

Section
Diagnosis [} page 99] 

Section 
Extended diagnosis [} page 105]

I/O monitor - Right click to the device icon of the master,
- select Diagnosis,
- select Tools > I/O monitor,
- check the input or output data.
- Close the dialog via OK.

Section I/O monitor [} page 119]

Disconnect - Right click to the device icon of the Master,
- select Disconnect.

Section Connecting/
disconnecting
device [} page 84]

Table 7: Getting started – Configuration steps

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Device start up 18/145

3.2 Create project configuration
1. Complete the slave device in the device catalog.

Ø Select Network > Import device descriptions.
Ø Import the device description file.

2. Load device catalog.
Ø Select Network > Device catalog.
Ø Select Reload catalog.

3. Create or open a project.
Ø Create new project / open existing project:
Ø Select File > New or File > Open.

4. Insert master device or slave device to the configuration.
Ø In the device catalog, click to the master device, and insert it via drag

and drop to the line in the network view.
Ø In the device catalog, click to the slave device.*
Ø Insert the slave device via drag and drop to the master bus line in the

network view.*

*This step will not be necessary if the network structure is scanned
automatically.

Note:
In order to select the desired device in the device catalog, note the
details about the DTM and the device at the bottom of the device
catalog window. When sorting by fieldbus, several devices with the
same name from different vendors can be displayed.

For further information, see operating instruction manual
"SYCON.net" or "netDevice and netProject".
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3.3 Access to online functions

Getting access to “Network scan”

Note:
If under Configuration > Master settings > Start of bus
communication the setting Controlled by application was
selected, the master device is in ‘Offline’ state after ‘Power on
Reset’! In this state, you cannot use the SYCON.net online function
Network scan.
Ø To access this online function when the master device is

working together with an application program, the application
program must start the communication.

Ø Alternatively, you can start the communication manually from
the context menu of the master device via Start
communication.

3.4 Importing network structure
As an alternative to manually configure the slave device, you can
automatically scan the network structure by using the context menu
Network scan and create the device. Then you can download the
configuration of the slave device to the master device.

Take the following steps:
1. Start the Network scan function.
2. Make the settings in the Scan response dialog of the master DTM.
3. Select Create devices.
4. Download the configuration of the slave device to the master device.

For more information, refer to the section Network scan [} page 88].
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3.5 Start/stop communication
You can manually start or stop the communication between an EtherCAT
Master device and EtherCAT Slave devices.
· Start communication can be enabled if the communication was

stopped before or if the configuration requires this (controlled release of
communication).

· Stop communication can be enabled if the communication was
started.

To start or to stop the communication, proceed as follows:

Start communication
Ø Connecting device:

Note:
To manually start the communication of the device at the bus, an
online connection from the EtherCAT Master DTM to the EtherCAT
Master device is required. Further information can be found in the
section Connecting/disconnecting device [} page 84].

Ø Select Additional functions > Service > Start communication from
the context menu (right mouse click).

ð The device communicates at the bus.

Stop communication

 Faulty system operation possible, overwriting of firmware
or loss of device parameters

Before stopping the communication:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

After carrying out the security measures:
Ø Select Additional functions > Service > Stop communication from

the context menu (right mouse click).
ð The communication of the device at the bus is stopped.
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4 Settings

4.1 Overview settings for driver and device assignment
Under "Settings" you can make different basic settings for your device:
· To establish a connection from the EtherCAT Master DTM to the

EtherCAT Master device, check whether the default driver is hooked up
in the dialog pane Driver and if necessary, check another or several
drivers.

· In the Device assignment pane, select the device and assign it to the
driver.

· The dialog in the Firmware download pane is used to load a new
firmware into the device.

· The dialog in the Licensing or License pane allows you to order
licenses for master protocols and utilities and transfer them to your
device.

Figure 4: Navigation area - Settings (example)

There may be more drivers.

Note:
To edit the dialog panes under Settings, you need the user rights
for "Maintenance".
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4.2 Verifying or adapting driver settings
The Driver dialog pane displays the drivers available to establish a
connection from the EtherCAT Master DTM to the device.

Note:
A default driver is set in the configuration software.

Proceed as follows:
1. Select driver.

Ø Select Settings > Driver in the navigation area.
ð The Driver dialog pane is displayed. This shows the available drivers

and the pre-setting of the default driver.

Figure 5: Default driver ‚cifX Device Driver’ for PC cards cifX (example)

Figure 6: Default driver ‚netX Driver’ for Hilscher devices except for PC cards cifX (example)

Parameter Description
Driver Name of the driver. (For further details, see the descriptions of the action steps.)

Default driver (Pre-settings in the configuration software): For PC cards cifX the cifX device driver is
preset as a default driver. For all the other Hilscher devices the netX driver is preset as a default driver.
To search for devices you can check multiple drivers simultaneously.

Version ODMV3 version of the respective driver
ID ID of the driver (driver identification)

Table 8: Parameters of the driver selection list

2. Verify whether the default driver is checked.
Ø To establish a connection from the EtherCAT Master DTM to the

EtherCAT Master device, check whether the default driver is hooked up
in the dialog pane Driver and if necessary, check another or several
drivers.

3. Respectively check another driver or multiple drivers.
Ø Check the checkbox for the driver in the selection list.

Note:
The driver used for the connection from the EtherCAT Master DTM
to the EtherCAT Master device must be supported by the device
and must be available for the device.
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· Use the cifX device driver if the EtherCAT Master DTM is installed on
the same PC as the EtherCAT Master device.

· Use the netX driver to establish an USB, Serial (RS232) or TCP/IP
connection from the EtherCAT Master DTM to the EtherCAT Master
device.

· The 3Sgateway driver for netX (V3.x) is used only in relationship with
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH.

To search for devices on the network you can check multiple drivers
simultaneously.

Figure 7: Manual selection of multiple drivers (example)
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4.3 Configuring drivers

4.3.1 cifX device driver
In the EtherCAT Master DTM for the cifX device driver no driver dialog
pane is available, since for the cifX device driver no driver settings are
required.

The cifX device driver will be used if the EtherCAT Master DTM is installed
in the same PC as the EtherCAT Master device.

Note:
To establish a connection from a DTM to a master device via the
cifX device driver, the cifX device driver must be installed and the
driver must have access to the master device.

4.3.2 netX driver
The netX driver is used to connect the DTM to the device via different
connection types. The DTM communicates with the device via an USB
connection, a serial (RS232) connection or a TCP/IP connection. The netX
Driver establishes
· via the USB interface of the device and the USB port of the PC an USB

connection to the device,
· via the RS232 interface of the device and the COM port of the PC a

serial connection (RS232) to the device,
· and, via Ethernet a TCP/IP connection to the device.

To connect the DTM to the physical layer of the device the netX driver
software works in combination with the software components:
· “USB/COM connector” for the USB connection and for the serial

connection (RS232) and,
· “TCP connector” for the Ethernet connection.

Descriptions of the netX Driver are available in the DTM user
interface as online help:
Ø Therefore, click Settings > Driver > netX driver and press the

F1 key.
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4.3.3 Configuring netX driver
The following steps are required to configure the netX driver:

USB/RS232 Connection

To set the driver parameters for an USB/RS232 connection note:

Note:
Adjust the driver parameters netX driver USB/RS232 only if they
differ from the default settings. After saving the changed driver
parameters, these parameters are used for the device assignment
when scanning devices.

For setting the driver parameters for an USB connection or a serial
connection:

1. Set the driver netX driver USB/RS232 parameters.
Ø Open the driver dialog via Settings > Driver > netX driver > USB/

RS232 connection.

TCP/IP connection

For setting the driver parameters for a TCP/IP connection:

2. Set IP address of the device.
Ø Select Settings > Driver > netX driver > TCP connection.

Ø Add an IP range via Select IP range .
Ø Under IP range configuration > IP address enter the IP address of the

device (Use IP range is unchecked).
3. Or set IP range:

Ø Check Use IP range.
Ø Under IP range configuration > IP address enter the start address

(left side) and the ending address of the IP scanning range (right side).
4. Save the IP address or the IP search range.

Ø Click on Save.
ð After saving the changed driver parameters, these parameters are used

for the device assignment when scanning devices.
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4.3.4 netX driver - USB/RS232 connection
The communication from the DTM to the device via an USB/RS232
connection is used when the DTM is installed on a PC and between the PC
and the device
· an USB connection,
· or a serial connection (RS232) exists.

The DTM accesses the device via the USB interface or via the RS232
interface. This requires either to connect an USB port of the PC to the USB
interface of the device using an USB cable or to connect a physical COM
port of the PC to the RS232 interface of the device via a serial cable.

The netX driver / USB/RS232 connection supports all physical and virtual
COM ports available on the PC.

Via the RS232 interface or USB interface, the device is configured or
diagnosis is performed.

4.3.4.1 Driver parameters for netX driver - USB/RS232 connection

The settings of the driver parameters for the USB/RS232 connection are
made via the netX driver / USB/RS232 connection configuration dialog.
Ø Open the USB/RS232 connection dialog via navigation area Settings

> Driver > netX driver.
Ê The USB/RS232 connection dialog is displayed:

Figure 8: cifX driver > USB/RS232 connection
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Parameter Description Range of value /
value

Enable USB/RS232
connector (restart of
ODM required)

checked: The cifX driver can communicate via the USB/RS232 interface.
unchecked: The cifX driver cannot communicate via the USB/RS232
interface.
If the check mark for Enable USB/RS232 connector is set or removed,
then the ODM server must be restarted1, to make the new setting valid.
_______
1 Restart the ODM server via the ODMV3 tray application:

- In the foot line click on  using the right mouse key.
- In the context menu select Service > Start.

checked, 
unchecked; 
Default: 
unchecked

Select port Depending on the COM ports (interfaces) available on the PC, they will be
listed under Select port.

COM 1 to COM N

Port configuration
Disable port checked: No connection.

unchecked: The cifX driver tries to establish a connection using the
configured USB/RS232 interface.

checked, 
unchecked (Default)

Baud rate Transfer rate: Number of bits per second.
The device must support the baud rate.

9.6, 19.2, 38.4, 57.6
bzw. 115.2 [kBit/s];
Default (RS232):
115.2 [kBit/s]

Stop bits Number of stop bits sent after the transfer of the send data for
synchronization purposes to the receiver.

Stop-Bit: 1, 1.5, 2;
Default (RS232): 1

Send timeout Maximum time before the transfer of the transmission data is canceled,
when the send process fails, for example, because of the transfer buffer is
full.

100 … 60.000 [ms]; 
Default (RS232 and
USB): 1000 ms

Reset timeout Maximum time for a device reset, including the re-initialization of the
physical interface used for the communication.

100 … 60.000 [ms];
Default (RS232 und
USB): 5000 ms

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit; 
Default (RS232): 8
Bit

Parity In the error detection in data transmission using parity bits, "parity"
describes the number of bits occupied with 1 in the transmitted
information word.
No Parity: no parity bit
Odd Parity: The parity is "odd" if the number of bits occupied with 1 in the
transmitted information word will be odd.
Even parity: The parity is "even" if the number of bits occupied with 1 in
the transmitted information word will be even.
Mark Parity: if the parity bit is always 1, this will be named mark-parity
(the bit does not contain any information).
Space Parity: if the parity bit always 0, this will be named space-parity
(the bit represents an empty space).

No Parity, 
Odd Parity,
Even Parity,
Mark Parity,
Space Parity;
Default (RS232): 
No Parity

Keep alive timeout The "Keep Alive" mechanism is used to monitor whether the connection
to the device is active. connection errors are detected using a periodic
heartbeat mechanism. The heartbeat mechanism will be initiated after the
set time has elapsed if the communication has failed.

100 … 60.000 [ms];
Default (RS232 und
USB): 2000 ms

Restore Resets all settings in the configuration dialog to the default values.
Save Saving all settings made in the configuration dialog cifX driver > USB/

RS232 connection, i. e. only for the selected connection type.
Save all Saving all settings made in the configuration dialog cifX driver, i. e. for all

connection types.
Table 9: Parameters cifX driver > USB/RS232 connection
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4.3.5 netX driver - TCP/IP connection
The communication from the DTM to the device via a TCP/IP connection
is used in the following two typical applications:

Application 1: The device has its own Ethernet interface. The DTM is
installed on a PC and the TCP/IP connection is established from this PC to
the stand-alone device. The IP address of the device is used.

Application 2: The device is installed in a remote PC. The DTM is installed
on an additional PC and the TCP/IP connection is established from this PC
to the remote PC. The IP address of the remote PC is used. For the TCP/IP
connection is made, on the remote PC the cifX TCP/IP server must be
started. The cifX TCP/IP server allows the remote access to the device via
a TCP/IP connection.

Note:
An exe file for the cifXTCP/IP server is provided on the product CD
in the Tools directory.

Via the TCP/IP interface of the device or of the remote PC, the device is
configured or diagnosis is performed.
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4.3.5.1 Driver parameters for cifX driver - TCP/IP connection

The settings for the driver parameters for the TCP/IP connection are made
via the netX driver / TCP connection configuration dialog.
Ø Open the TCP connection dialog via navigation area Settings > Driver

> netX driver.
Ê The dialog netX driver is displayed:
Ø Select TCP connection.

Figure 9: netX driver > TCP connection

Parameter Description Range of value /
value

Enable TCP
connector (restart of
ODM required)

checked: The cifX driver can communicate via the TCP/IP interface.
unchecked: The cifX driver cannot communicate via the TCP/IP interface.
If the check mark for Enable TCP connector is set or removed, then the
ODM server must be restarted1, to make the new setting valid.
_______
1 Restart the ODM server via the ODMV3 tray application:

- In the foot line click on  using the right mouse key.
- In the context menu select Service > Start.

checked, 
unchecked; 
Default: 
unchecked

Select IP range Via Select IP range already created IP ranges can be selected.

Via  an additional IP range can be added. 

Via  an IP range can be deleted.
Scan timeout [ms] With Scan timeout can be set, how long to wait for a response while a

connection is established.
10 … 10.000 [ms];
Default: 100 ms

IP range configuration
Disable IP range checked: No connection.

unchecked: The cifX driver tries to establish a connection using the
configured TCP/IP interface.

checked, unchecked
(Default)
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Parameter Description Range of value /
value

IP address (links) Enter the IP address of the device, (if Use IP range is not checked).
Enter the IP address of the device, (if Use IP range is not checked).

valid IP address; 
Default: 192.168.1.1

Use IP range checked: An IP address range is used.
unchecked: Only one IP address is used.

checked, 
unchecked;
Default: unchecked

IP address (right) Enter the end address of the IP scanning range, (only if Use IP range is
checked).

valid IP address; 
Default: 0.0.0.0

Address count Displays the scanning range address count, depending on the selected
IP-start or IP-end address. (For this read the note given below.)

recommended: 10

TCP Port Identifies the endpoint of a logical connection or addresses a specific
endpoint on the device or PC.

0 – 65535; 
Default Hilscher
device: 50111

Send timeout Maximum time before the transfer of the transmission data is canceled if
the send process fails, for example, because of the transfer buffer is full.

100 … 60.000 [ms];
Default (TCP/IP):
1000 ms

Reset timeout Maximum time for a device reset, including the re-initialization of the
physical interface used for the communication.

100 … 99.999 [ms];
Default (TCP/IP): 
20.000 ms

Keep alive timeout The "Keep Alive" mechanism is used to monitor whether the connection
to the device is active. Connection errors are detected using a periodic
heartbeat mechanism. The heartbeat mechanism will be initiated after the
set time has elapsed if the communication has failed.

100 … 60.000 [ms];
Default (TCP/IP):
2000 ms

Restore Resets all settings in the configuration dialog to the default values.
Save Saving all settings made in the configuration dialog cifX driver > TCP/IP

connection, i. e. only for the selected connection type.
Save all Saving all settings made in the configuration dialog cifX driver, i. e. for all

connection types.
Table 10: Parameters netX driver > TCP connection

Note:
Do not use large IP ranges in combination with a low scan timeout.
Microsoft introduced in Windows® XP SP2 a limit of concurrent half-
open outbound TCP/IP connections (connection attempts), to slow
the spread of virus and malware from system to system. This limit
makes it impossible to have more than 10 concurrent half-open
outbound connections. Every further connection attempt is put in a
queue and forced to wait. Due to this limitation, a large IP range
used in combination with a low scan timeout could prevent the
connection establishment to a device.
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4.4 Assigning device (with or without firmware)

Note:
In the Device assignment dialog pane, you first must assign the
EtherCAT Master device to the EtherCAT Master DTM by checking
the check box. This is essential to establish an online connection
from the EtherCAT Master DTM to the EtherCAT Master device
later, as described in section Connecting/disconnecting
device [} page 84].

Therefore, in the Device assignment dialog pane you scan for the
EtherCAT Master device and select it.

If the device did not get a firmware or shall get a new firmware:
1. First you scan for the device (with or without firmware) and select the

device,
2. then you download a firmware to the device, and
3. subsequently you scan for the device (with firmware) once more and select

the device again.
Ø Proceed in the order mentioned.

4.4.1 Scanning for devices
Ø Select Settings > Device assignment in the navigation area.
Ê The dialog pane Device assignment is displayed.
Ø Under Device selection, select suitable only.
Ø Select Scan, to start the scanning process.
ð In the table all devices are displayed, which can be connected to the

EtherCAT Master DTM via the preselected driver.

Figure 10: Device Assignment - detected devices (example: device without firmware)

Note:
For devices, which have been found via the cifX device driver in
the column Access path the indication …\cifX[0toN]_SYS is
displayed. This is correct, as long as a device did not get a
firmware. After the firmware download has been completed, in the
column Access path the indication …\cifX[0toN]_Ch[0to3] is
displayed.
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Parameter Description Range of value /
value

Device selection Selecting suitable only or all devices. suitable only, all
Device *The device name (= name of the device class) of the EtherCAT Master

device appears.
Hardware Port 0/1/2/3 Shows, which hardware is assigned to which communication interface.
Slot number Shows the Slot number (card ID), preset at the PC card cifX via the

Rotary switch slot number (card ID).
The indication n/a means, that no Slot nummer (card ID) exists. This will
occure if the PC card cifX is not equipped with a Rotary switch slot
number (card ID)or for PC cards cifX equipped with a Rotary switch
slot number (card ID) if the rotary switch is set to the value 0 (zero).

1 to 9,
n/a

Serial number Serial number of the device
Driver Name of the driver.
Channel Protocol Shows, which firmware is loaded to which device channel. 

The data for the used channel consists of the protocol class and the
communication class.
a.) For devices without firmware: Undefined Undefined, 
b.) For devices with firmware: Protocol name corresponding to the used
Firmware

Access path 
(last column on the
right)

Depending on the used driver in the column Access path different data to
the device is displayed.
For the cifX device driver the following data is displayed: 
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3

Depending on the
device and on the
driver: 
board or channel
number, IP address
or COM interface

Access path 
(at the lower side of
the dialog pane)

If in the table a device is checked, under Access path (at the lower side
of the dialog pane) the driver identification or depending on the used
driver additional data to the device will be displayed.
For the cifX device driver the following data is displayed: 
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = Board number 0 to N
Ch[0to3] = Channel number 0 to 3

Driver identification
(ID)
Depending on the
device and on the
driver: 
board or channel
number, IP address
or COM interface

Table 11: Parameters of the Device Assignment
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4.4.1.1 Selecting suitable only or all devices

All
Ø Under Device selection select all.
Ø Select Scan.

Figure 11: Device Assignment - detected devices (example: device without firmware)

Ê In the table all devices are displayed, which are attainable in the
network and which can be connected to a single DTM each via the
preselected drivers.

Note:
During a subsequent firmware download in the selection window
Select firmware file all files from the selected folder are displayed,
under Files of type „All Files (*.*)“ is displayed and the check box
Validate the selected firmware file. is unchecked.

suitable only
Ø Under Device selection select suitable only.
Ø Select Scan.
Ê In the table all devices are displayed, which can be connected to the

EtherCAT Master DTM via the preselected driver.

Note:
During a subsequent firmware download in the selection window
Select firmware file only firmware files from the selected folder are
displayed, under Files of type „Firmware Files (*.nxm)“ or
„Firmware Files (*.nxf)“ is displayed and the check box Validate the
selected firmware file. is checked.
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4.4.2 Selecting the device (with or without firmware)

Note:
A connection with the EtherCAT Master DTM can only be
established with one EtherCAT Master device.

To select the physical EtherCAT Master device (with or without firmware):
Ø Check the appropriate device.
Ê Under Access path (below in the dialog pane) the access path to the

device, e. g. the driver identification, or depending on the used driver
additional access data of the device is displayed.

Ø Select Apply, to apply the selection.

Figure 12: Device Assignment - selecting device (example: device without firmware / one
device selected)

Note:
Before an online connection from the EtherCAT Master DTM to the
EtherCAT Master device can be established, a firmware must be
loaded to the device and the device must be selected once more.

For further information refer to section Selecting and downloading
firmware [} page 36] or to section Selecting the device once more (with
firmware) [} page 34].

4.4.3 Selecting the device once more (with firmware)

Note:
For repeated download this step is omitted.

To select the EtherCAT Master device (with firmware and defined system
channel) once more, proceed as described hereafter:
Ø Under Device selection select all or suitable only.
Ø Select Scan.
Ê For selection All: The table shows all devices which can be reached in

the network and which can be connected to a DTM via the preselected
drivers.

Ê For selection suitable only: In the table all devices are displayed, which
can be connected to the EtherCAT Master DTM via the preselected
drivers.

Ø Check the appropriate device.
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Ø Select Apply, to apply the selection.
Ø Or select OK, to apply the selection and to close the DTM interface

dialog.
Ø Connect the DTM to the device using the context menu (right mouse

click).

Figure 13: Device Assignment - selecting device (example: devices with and without
firmware / one device selected)

Note:
After the firmware download has been completed, for the devices
which have been detected via the cifX Device Driver the following
data is displayed:
In the column Channel protocol: The data for the firmware for the
used channel
In the column Access path or under Access path (below in the
dialog pane): The data: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = board number 0 to N
Ch[0to3] = channel number 0 to 3

For further information how to establish an online connection from the
EtherCAT Master DTM to the EtherCAT Master device, refer to section
Connecting/disconnecting device [} page 84].
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4.5 Selecting and downloading firmware

Requirements

Note:
Before downloading the firmware, you must select the driver and
the master device (with or without firmware) and assign the
hardware to the device. For more information, see sections on
driver settings and device assignment.

How to proceed

You can use the dialog Firmware download to transfer a firmware to the
device. Load the firmware into the device as described below:

1. Select the firmware file.
Ø In the navigation area, select Settings > Firmware download
Ê The dialog pane Firmware download is displayed.

Figure 14: Firmware download

Element Description
Name The path and name of the selected firmware file are displayed.
Version The version and build version of the selected firmware file are displayed.
Browse… Via "Browse..." you can select the firmware file to download.

Note! If the device is not assigned to the hardware, the error message "The
device is not assigned to the hardware!" is displayed.

Download Via "Download" you can download the firmware to the device.
Table 12: Firmware download parameters

Ø Select Browse....
Ê If the device is not assigned to the hardware, the error message "The

device is not assigned to the hardware!" is displayed.
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Figure 15: Error Message "The device is not assigned to the hardware!"

Ø Click OK and select and assign the master device as described in
section Assigning device (with or without firmware) [} page 31].

Ê If a hardware has been assigned to the device, the selection window
Select firmware file opens.

Ø Enlarge the selection window to view the columns Hardware and
Version.

Figure 16: "Select firmware file" selection window (example CIFX)
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Parameter Description Range of value /
value

Column Name File name of the firmware file
To sort the entries of the window Select firmware file by name click to

the column head .

nxf, nxm

Column Firmware Name of the firmware (consisting of the protocol name and the protocol
class)

Column Hardware Device class of the assigned hardware e. g. CIFX, 
COMX, COMX 51, 
NETJACK 10, 
NETJACK 50, 
NETJACK 51, 
NETJACK 100,
NETTAP 50
(Gateway),
NETTAP 100
(Gateway),
NETBRICK 100
(Gateway)

Column Version Firmware version x.x (build x)
Tooltip To view the tooltip display, move the mouse pointer over the selected

firmware line.

File of Type "All Files (*.*)" if before in the Device assignment pane the list entry all
was selected.
"Firmware Files (*.nxm)" or "Firmware Files (*.nxf)" if before in the Device
assignment pane under Device selection - suitable only was selected.

All Files (*.*),
Firmware Files
(*.nxm),
Firmware Files
(*.nxf)

Recent folders Path of the recently opened folder
Firmware As soon as the firmware file has been selected, under Firmware the

name, the version and the build version as well as the device class for the
selected firmware is displayed.

Name, Version,
Build Version,
Device Class for the
selected firmware

Help Button to open the online help of the DTM.
Table 13: Parameters “Select firmware file”

Further descriptions to the selection window Select firmware file
are included in the context sensitive help (F1 key) of the Microsoft
Corporation.

Note:
After in the Device assignment pane under Device selection - all
or suitable only has been set, during a subsequent firmware
download in the selection window Select firmware file the following
data is displayed or set:
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(for the list box entry ->) all suitable only
In the selection window Select
firmware file:

all files from the selected
folder

only firmware files from the
selected folder

Under File of type*: "All Files (*.*)" "Firmware files (*.nxm)",
"Firmware Files (*.nxf)"

Validation: A restricted validation will
be performed if the
selected firmware is
applied for the download.

A validation is made whether
the firmware file is suitable
for the EtherCAT Master
DTM.

These settings in the selection window Select firmware file can also be changed
manually.

Table 14: In the selection window "Select firmware file"

Ø In the selection window mark the firmware file to be loaded using the
mouse.

Ê In the selection window under Firmware the name and the version of
the firmware are displayed.

Ø In the selection window select the Open button.
Ê A validation is made, whether the selected firmware file is suitable for

the EtherCAT Master device.
Ê If a firmware file has been selected that is valid for the selected device,

the selection window closes immediately (without dialog).
Ê If a firmware file has been selected that is not valid for the selected

device, the query Select firmware file appears:
"Invalid firmware for assigned device! 
[detailed explanation]
Should the firmware file nevertheless be applied for the download?"

Figure 17: Request Select firmware file - Example Invalid Firmware
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 Invalid firmware

Loading invalid firmware files could render your device unusable.
Ø Only proceed with a firmware version valid for your device.
Ø Answer to the request with No and select a valid firmware.
Ê The selection window closes.

2. Transmit firmware to the device.
Ø Note the following safety information:

 Communication stop caused by firmware update, faulty
system operation possible, overwriting of firmware or loss of device
parameters

Before you initiate a firmware download process, while the bus is still in
operation status:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

 Firmware corruption or loss of parameters caused by
power disconnect during firmware download
Ø During firmware download process, do not interrupt the power supply to

the PC or to the device, and do not perform a reset to the device!
Ø In the dialog pane Firmware download click to the Download button,

to download the firmware.
Ê The request Do you really want to download the firmware? is

displayed.

Figure 18: Request - Do you really want to download the firmware?

Ø Click Yes.
Ø If you are sure, that you have selected the appropriate firmware file

answer to the request with Yes otherwise with No.
Ê During the download, a progress bar is displayed ("Download active,

device performs initialization…"), in the status line a clock / green hook
symbol is displayed and in the dialog pane Firmware download the
button Download is grayed out.

Ê In the Firmware download dialog pane the path and name as well as
the version of the selected firmware file are displayed.
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Figure 19: Firmware download - progress bar

Figure 20: Clock symbol and hook symbol green

Figure 21: Firmware download - download
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4.6 Licensing
To open the Licensing pane:
Ø In the navigation area select Settings > Licensing.
Ê The dialog pane Licensing is displayed.

Figure 22: Licensing

Using the license dialog, you can order licenses for Master protocols and
Utilities and transfer them to your device. Further information on the
license dialog is described in the section Licensing [} page 43].
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5 Licensing
Using the license dialog, you can order licenses for Master protocols and
Utilities and transfer them to your device.

5.1 Opening license dialog
You first open the License window.

Note:
You first need to assign the master device to the DTM. Only then
the device data and the licenses already present in the device are
displayed in the License dialog.

How to proceed:
1. Assign the master device to the DTM.

Ø In the FDT container netDevice, double click to the device icon.
Ø Select Settings> Driver.
Ø Select one or several drivers (checking).
Ø Select Settings > Driver > [Name of the assigned driver].
Ø Configure the driver settings if necessary.
Ø Select Settings > Device assignment.
Ø Under Device selection, select suitable only or all and click Scan.
Ø In the table, check the required device.
Ø Click Apply.
Ø Close the DTM configuration dialog via OK.

For details to the device assignment, refer to section Settings [} page 21].
2. Open the License pane.

Ø Right-click on the device icon in the FDT container netDevice.
Ø From the context menu, select Additional functions> License.
ð The License window opens.
ð The title bar contains the notation of the device description: Symbolic

Name [Device Description] <Station Address > (#Network ID).
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5.2 License dialog
In the License pane, you can:
· check, which licenses for Master protocols or Utilities are present in the

device (Position (1) in the figure below),
· order licenses (Positions (2) to (11)),
· transfer license to the device (12),

Figure 23: License pane

Note:
To display further entries under License Type, move the scroll box
(a) downwards or upwards. To display further entries under
Request form, please fill out, move the scroll box (b) downwards
or upwards.
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5.3 Which licenses are present in the device?
Check, which licenses are present in the device.

How to proceed:
Ø Open the License pane as described under section Opening license

dialog [} page 43].

Figure 24: License pane - License Type

Ø Under License type click  at Master protocols.
Ê The Master protocols overview opens:

Figure 25: License pane – License Type / Master protocols

Ø Or click  at Utilities.
Ê The Utilities overview opens:

Figure 26: License pane – License Type / Utilities

Ê The column Existing indicates which licenses are present in the device.

Yes = License is present in the device.

No = License is not present in the device.

Note:
In newer versions of the present configuration software, under
License type may be displayed additional licenses or other
protocols that can be ordered later.
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5.3.1 License for master protocols
One General Master License:

On the device maximally 1 communication protocol with master function
can be implemented.

Two General Master Licenses:

On the device maximally 2 communication protocols with master function
can be implemented.

The license includes the following master protocols:
· AS-Interface Master
· CANopen Master
· DeviceNet Master
· EtherCat Master
· EtherNet/IP Scanner
· PROFIBUS Master
· PROFINET IO RT Controller
· Sercos Master

5.3.2 Licenses for utilities
SYCON.net

OPC Server

QVis Minimum Size
· QVis Standard Size
· QVis Maximum Size
· CoDeSys Minimum Size
· CoDeSys Standard Size
· CoDeSys Maximum Size

For the Utilities QVis and CoDeSys only one license can be selected
alternatively:
· Minimum Size,
· Standard Size or
· Maximum Size.
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5.4 How to order a license?
To order a license, proceed as follows:

1. Open the license dialog.
Ø Refer to Section Opening license dialog [} page 43].

2. Select the required licenses.
Ø Refer to Section Selecting license(s) [} page 47].

3. Enter the ordering data.
Ø Refer to Section Ordering data [} page 48].

4. Place your order.
Ø Refer to Section Ordering the license [} page 50].

5.5 Selecting license(s)
You can select licenses for Master protocols and / or Utilities.

1. Selecting license(s) for Master protocol(s):
Ø In the License pane under License type click  at Master protocols.
Ø Under Order check as many licenses must run simultaneously on your

device: 
One General Master License or 
Two General Master Licenses.

2. And/or select license(s) for utility(utilities):
Ø In the License pane under License type click  at Utilities.
Ø Under Order check the required utility(utilities) 

(single or several):
· SYCON.net
· OPC Server
· QVis Minimum Size*
· QVis Standard Size*
· QVis Maximum Size*
· CoDeSys Minimum Size**
· CoDeSys Standard Size**
· CoDeSys Maximum Size**

For *) and **) minimum size, standard size or maximum size can be
selected only as an alternative.
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5.6 Ordering data
· Device information

The "Device Information" required for the order are read from the device
and automatically filled in the order.
· Ordering Data
Ø Enter the Ordering Data into the License pane.
Ø Enter the Data to manage the Order (therefore refer to section Data to

manage the order (license information) [} page 49]).

5.6.1 Device information (ordering data read from the device)
The following ordering data is read from the device and displayed in the
License pane:
· Manufacturer
· Article number
· Serial number
· Chip type
· Step (chip revision)
· Romcode revision
· Checksum (checksum of the device data)

The gray fields under Request Form, please fill out > Value contain the
ordering data read from the device:

Figure 27: License pane - request form, please fill out / device information

These ordering data read out from the device are displayed automatically
from the device.
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5.6.2 Data to manage the order (license information)
For your order, you must enter the following data to the License pane:
· License type (User Single Device License).

Figure 28: License pane - Request form, please fill out / License type

Ø Select the license type under Request form, please fill out > Value,
(for future application, currently only User Single Device License can be
selected).

· Mandatory data to the order request (editable fields):
– First name
– Surname
– E Mail (address, to which the license download link shall be send.)
– Telephone
– Company
– Address
– Country
– City, State, Zip

Figure 29: License pane - request form, please fill out / mandatory data

Ø Enter all mandatory fields under Request form, please fill out > Value
(marked with*).

· Additional order data, not mandatory (editable fields):
– Fax
– Customer number
– Order number
– Value added tax identification number

Ø Under Request form, please fill out > Value enter all fields for the
additional data, which is not mandatory.
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5.7 Ordering the license
Place your order in the License pane. Therefore:

Figure 30: License pane – selecting the subsidiary / ordering / contacts

Ø Select the subsidiary (4), to which the order shall be send.
Ø Place the order:
· by E-Mail (5),
· or by Fax (6) or by Telephone (7),
· or in a file (8).

The Contact data of the selected subsidiary is displayed under the
positions (9), (10) and (11).
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5.7.1 Ordering the license by e-mail
You can place your order by e-mail.
Ø In the License pane, click e-mail… (5).
Ê The order e-mail License request opens:

Figure 31: Example: Order e-mail License request

The order e-mail License request contains:
· the E-mail… of the selected subsidiary (a),
· the automatically generated XML file (b) EmailOrderRequest_-

[Devicenumber]_[Serialnumber].xml with a summary info of the order
information,

· the Order address (c),
· the License information (d),
· the License type (e),
· the Device information (f),
· the ordered licenses (g).
Ø Send the order e-mail License request.
ð The order process is complete.
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5.7.2 Ordering the license by fax or by telephone
You can place your order by fax or by telephone.
Ø In the License pane, click Print fax form (6) or Telephone… (7).
Ê The summary of the ordering data PrintOrderRequest_[Devicenum-

ber]_[Serialnumber].html is opened in a browser window.

Note:
If your browser does not display the order data or the window Move
element or Copy element is displayed, check the safety settings of
your system.

Figure 32: Example: Order data form PrintOrderRequest
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The order data form contains:
· the Order address (c) ,
· the License information (c),
· the License type (e),
· the Device information (f),
· the ordered Licenses (g).
Ø Print the order data form, sign it and send it by fax.
Ø In the License pane, use the Fax number (10), which is displayed after

the subsidiary, was selected.

Or:
Ø Keep ready the data form and communicate the order data via

telephone.
Ø In the License pane, use the telephone number (11), which is displayed

after the subsidiary, was selected.
ð The order process is complete.

5.7.3 Exporting license request to a file
If you are working on a process computer without an e-mail client, you can
export your order information to a file, save the file to a removable disk and
place your order manually via e-mail from a different PC.
Ø In the License pane, click Export license request… (8).
Ê The window Browse for folder is displayed.
Ø Choose for or create a new folder on a removable disk.
Ø Save the automatically generated XML file EmailOrderRequest_-

[Devicenumber]_[Serialnumber].xml with a summary info of the order
information to this folder.

Ø Send this file from a PC with an e-mail client manually via e-mail.
Ø Therefore use an e-mail address, which is displayed after the subsidiary

was selected in the License pane (see Position (9), figure License
pane [} page 44]).

ð The order process is complete.

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Licensing 54/145

5.8 How to get the license and transfer it to the device

Note:
License files can only be delivered via e-mail. The e-mail contains a
link to download the license file.

According to the license you ordered, you will receive an e-mail containing
a Link to download the license file. This leads to a server PC on which
the license file is provided. Using the received link you will have to save the
license file on your PC and then transfer the license to your device. If your
e-mail client is on another PC as your device, you must save your license
file e. g. to an USB stick.

Steps on how to proceed
1. Save the license file to a PC or a disk.

Ø Click to the Link to download the license file in the e-mail.
Ø Save the license file *.nxl to a PC or a removable disk.

2. Download the license file to the device.
Ø Respectively connect the removable disk with the license file to the PC,

which is connected to your device.
Ø In the License pane, click Download license (12) in the License pane

in the configuration software.
Ê The file selection window Open is displayed.
Ø Therein select the license file netX License Files (*.nxl).
Ø Click Open.
Ê The license file is transferred to the device.
Ê After this the license is present in the device and is activated with the

next device reset.

Note:
To activate the license in the device for the first time, a device reset
is required.

3. Activate device reset
Ø To check whether the license has been activated, follow the steps in

section Which licenses are present in the device? [} page 45].

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Configuration 55/145

6 Configuration

6.1 Overview of configuring device parameters
Under "Configuration", you can configure your device.
· In the General window, general settings for the EtherCAT Master can

be adapted (a description, the device name, the parameters
synchronization and redundancy).

· Under Process Data Handshake, the method to be used for the
process data handshake is selected.

· In the Topology window, the network topology can be edited in the
connection view.

· Under Mailbox, (for slaves with configurable CoE parameters) entries
can be made on the 'Start-up' and 'Userdef Start-up' tabs.

· The parameters for FMMU and the Sync-Manager can be set in the
FMMU/SyncMan window.

· The Process data pane serves as a process data interface for the
EtherCAT Master DTM to the outside.

· The Address table shows a list of all addresses used in the process
image memory.

· In the Init Commands window, the Init commands can be edited
according to the requirements.

Figure 33: Navigation area – Configuration

Note:
To edit the dialog panes under Configuration, you need the user
rights for "Maintenance".
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For further information about configuration, see the sections:
· General [} page 57]
· Process data handshake [} page 60]
· Topology [} page 60]
· Mailbox [} page 67]
· FMMU/Sync Man [} page 74]
· Process data [} page 77]
· Address table [} page 79]
· Init commands [} page 81]
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6.2 General
The General dialog pane shows the current device name (editable) and the
description of the EtherCAT Master, and also allows performing basic
settings (synchronization mode, redundancy, timing, target state).
Ø Select Configuration > General in the navigation area.

Figure 34: Configuration > General

Parameter Description Range of Value /
Value

Name of Station Network name of the EtherCAT Master station. Must be a DNS
compatible name.

1 - 240 characters

Device name Symbolic name of the EtherCAT Master DTM.
Synchronization mode EtherCAT Slave devices can operate in different synchronization modes.

There is the choice between three synchronization modes. These modes
are required for the distributed clocks features.

Freerun only
Freerun with DC 
DC Synchronized

Reference clock In this field, the DTM automatically displays the device name with
appended AutoInc and Station Addresses’ values.

Activate redundancy This checkbox shall be marked if working with redundancy is intended. If
you use distributed clocks or do not intend working with redundancy, then
do not mark this checkbox.
Redundancy: Cabling variant in which each device is connected twice to
its neighboring nodes in the network. The advantage is the significantly
increased reliability.

checked,
not checked
Default: not checked

Freerun cycle (μs) Cycle time of the EtherCAT Master running free.
This parameter is only relevant when running the EtherCAT Master
firmware V3 and configuring it via *.nxd file (not *.xml).

>= 250 μs
Default: 1000 μs
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Parameter Description Range of Value /
Value

Target state Desired state of the EtherCAT Master.
This parameter is only relevant when running the EtherCAT Master
firmware V3 and configuring it via *.nxd file (not *.xml).

Init
Pre-Operational
Safe-Operational
Operational

Table 15: Parameters of the General dialog pane

Ø Edit the text in the Description field, to change the name of the device
according to your needs.

The following synchronization modes can be selected under
Synchronization > Mode:

Figure 35: EtherCAT Master DTM, “General” dialog pane, synchronization modes

These have the following meaning:
· „Freerun Only‟ -> no synchronization
· “Freerun with DC” -> synchronized on SyncManager event when

process data is written (read)
· „DC Synchronized” -> synchronized on DC sync event

The following actions only apply to the ‘EtherCAT Master firmware V3’.
Ø In case Freerun with DC or DC Synchronized is activated, the first

EtherCAT Slave with DC enabled will be used as the reference clock.
EtherCAT Master cyclically has to read the bus time from the
appropriate register of the clock master and write this value in the
corresponding registers of all other DC slaves.

Ø Adjust the desired cycle time of the EtherCAT Master for free running
operation. Values lower than 250 μs are not permitted. Avoid larger
values of the free running cycle time than 5000 μs as there is no
experience with such long cycle times, these have not been tested.

Ø Adjust the desired target state of the EtherCAT Master.
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Synchronization modes for EtherCAT Slave devices

In general, there are three synchronization modes:
· Free run – Local timer: The EtherCAT Slave exclusively uses local

timers and does not synchronize with any external time sources at all.
· Sync. with SM2/3 SyncManager Event: The EtherCAT Slave

synchronizes with sync managers for output or input.
· Sync. with DC Sync Event (Sync0/Sync1 Hardware Signals): The

EtherCAT Slave synchronizes with the Sync0/Sync1 hardware signals
by the EtherCAT Slave hardware.

Error messages

The following error messages may be issued when errors occur while
specifying data:

Invalid cycle time for free run (i.e. value too small (< 250) or too large
(>65535)):

Figure 36: Error "Invalid freerun cycle"

Action to be done:

Put in a value within the specified range of permitted values between 250
and 65535.

When synchronization mode is [Freerun with DC] or [DC
Synchronized], it is not allowed to activate redundancy!

Figure 37: Error "When synchronization mode is [Freerun with DC] or [DC Synchronized], it
is not allowed to activate redundancy!"

Action to be done:

Distributed clocks and redundancy exclude each other. Decide, whether
you prefer working with distributed clocks or with redundancy and select the
settings accordingly!
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6.3 Process data handshake
The application and stack use a handshake mechanism that regulates
access to the process data.

In the navigation pane, select Configuration > Process Data Handshake.

Figure 38: Configuration > Process data handshake

The handshake for the input process data offers the following options:
· Buffered, host controlled: This setting corresponds to "Free run". The

application and the network cycle run "free", i.e. the handshake is not
synchronized with the network cycle.

· Buffered, host controlled, sync at received input data: This setting
corresponds to "Synchronization mode 2". The stack triggers the
handshake after receiving the input process data.

· Buffered, host controlled, sync at start of cycle: This setting
corresponds to "Synchronization mode 1". The stack triggers the
handshake after the network cycle has been started.

The handshake for the output process data is always Buffered, host
controlled.

6.4 Topology

6.4.1 Tree view
The dialog pane Topology, Tree view displays the ‘Tree view’ of the
topology providing an overview about the structure of the EtherCAT
network.
Ø Select Topology > Tree view in the navigation area.
Ê The upper part of the dialog pane shows the structure tree of the current

configuration of the EtherCAT network.
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Figure 39: Topology >Tree view

The first element of the tree is the EtherCAT project, which is located on
the highest hierarchy level. One level below you find the EtherCAT Master
device. A further level below you can find simple and complex EtherCAT
Slaves.

For all slaves the station address and both the short and the long form of
the device name are included in the tree view. Complex slaves can be
recognized by expandable entries while the entries belonging to simple
slaves cannot be expanded.

Left of the device entry in the tree there is a checkbox. Checking it denotes
deactivating the slave that is the slave device will be excluded from the
configuration, removing also all ports’ connection information. If you do so,
the device entries’ checkbox is marked with a red cross. In order to activate
the device again, it is just necessary to uncheck the box and reconnect the
device as needed.

If you click at a slave’s entry in the screen with right mouse button, a
context menu appears.
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Figure 40: Context menu with the entry ‘Open Slave DTM’

Choosing the ‘Open Salve DTM’ entry will open the configuration dialog of
the corresponding EtherCAT Slave’s DTM. This allows quickly adjusting
slave parameters when checking the EtherCAT Master’s configuration.

If you click at any entry in the screen with left mouse button, the entry will
be highlighted. If the entry was not the project entry, the name of the device
is displayed in an editable field within the ‘Device info’ area of the dialog
pane. This allows changing the name of device, if necessary. Changes
made by editing the field are stored by clicking the ‘Update’ button. The
corresponding entries in the tree view of the network topology are adapted
accordingly then. An ‘Update’ button is available for the following input
fields:
· Name in ‚Device info’ area
· Station address in ‚Device info’ area
· Name in ‚Project info’ area

About possible errors during updating, see below.

The ‘Device info’ area also provides the following information besides the
name of the device:
· The ‘Station address’ (only if an EtherCAT Slave has been selected

previously). This field is also editable and has an ‘Update’ button
allowing to store changes, if necessary.

· The read-only ‘Auto Increment’ value according to the EtherCAT
specification. This field is not editable.

· The read-only field ‘Physics’ denotes the physical medium (and thus the
port type) used for the connections. In addition, this field is not editable.

Physics in the context of EtherCAT port configuration is described by a
sequence of up to four characters (depending on the number of ports)
indicating the port type(s) to be applied. The coding is as follows:
Physics Port type
K E-Bus
Y 100Base-TX
F 100Base-FX

Table 16: Coding of parameter "Physics"

The ‚Project info’ area always shows the name of the project in an editable
field, again along with a respective ‚Update’ button. It also displays both the
number of configured and of deactivated slaves.

The following error messages may be issued when errors occur while
updating:

1. Wrong station address (i.e. value too small or too large):
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Figure 41: Error "Wrong station address"

Action to be done:
Ø Put in a value within the specified range of permitted values between 0

and 65535.

2. Wrong station name:

Figure 42: Error "Wrong station name"

Action to be done:
Ø Put in a valid name (i.e. not empty, does not contain any special

characters).
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6.4.2 Connection view
The dialog pane Topology, Connection view displays the topology tree in
connection view allowing you to check how all EtherCAT Slave devices
configured for use with the EtherCAT Master are connected.
Ø Select Topology > Connection view in the navigation area.
Ê A screen similar to the following will appear:

Figure 43: Topology > Connection view

The color coding is:
· Yellow lines indicate Ethernet connections (such as 100-TX).
· Red lines indicate Beckhoff E-Bus connections.

Note:
To fix or pin a device’s position in the view, right-click on it and
choose the option ‘Pin device’ from the context menu appearing
then. Fixed devices are marked with a blue arrow symbol. To unpin
it, right-click on it and choose the option ‘Unpin device’ from the
context menu in the same manner, also see below.
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In order to restore the initial state of the arrangement after reordering
EtherCAT Slave devices of the EtherCAT network, do the following:
Ø Click at the ‘Auto arrange’ button
Ê The initial state of the arrangement is restored then.

The ‘Find device’ functionality allows you to easily locate any EtherCAT
Slave device in the graphical representation of the EtherCAT network
topology.
Ø Open ‘Find device’.
Ê All devices of the network are listed there.
Ø Select the name of the desired device.
Ê An additional lamp symbol will indicate the location of the chosen device

in the connection view of the EtherCAT network topology

Multiple tool tip for devices is available which is composed of the title
“Selected device’s info”.

Figure 44: “Selected device’s info”

The following information about this device is displayed:
Item Description
Descr. Description, i.e. long and short form of device name
Physics Used port type, see below
AutoInc Auto increment address as described in the EtherCAT specification.
Logical Logical address (i.e. station address)

Table 17: Information displayed when pointing at a symbol of a device

Physics in the context of EtherCAT port configuration is described by a
sequence of up to four characters (depending on the number of ports)
indicating the port type(s) to be applied. The coding is as follows:
Physics Port type
K E-Bus
Y 100Base-TX
F 100Base-FX

Table 18: Coding of parameter “Physics”

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Configuration 66/145

In order to open the context menu of any EtherCAT Slave device, proceed
as follows:
Ø Perform a mouse click with the right mouse button at the graphical

representation of the desired EtherCAT Slave device.
Ê The context menu will be opened.

If the selected EtherCAT Slave device has not been fixed previously (i.e. it
has not been marked with a blue arrows), the context menu offers the
following entries

‘Pin device’
Fixes (or pins) the device in the connection view.

‘Open Slave DTM’
If you choose this context menu option, the configuration dialog
of the corresponding EtherCAT Slave’s DTM will be opened.
This allows quickly adjusting slave parameters when checking
the EtherCAT master’s configuration.

Table 19: Context menu entries for unpinned EtherCAT Slave devices in connection view

If the selected EtherCAT Slave device has been fixed previously (i.e. it has
been marked with a blue arrows), the context menu offers the following
entries

‘Unpin device’
Inhibits fixing (pinning) the device in the connection view.

‘Open Slave DTM’
If you choose this context menu option, the configuration dialog
of the corresponding EtherCAT Slave’s DTM will be opened, see
above.

Table 20: Context menu entries for pinned EtherCAT Slave devices in connection view
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6.5 Mailbox

6.5.1 CoE
The CoE dialog pane displays information about the CoE (CANopen over
EtherCAT) functionality for acyclic, mailbox-based communication.
Ø Select Mailbox > CoE in the navigation area.

Figure 45: Mailbox > CoE

The upper part of the dialog pane displays a topology tree allowing an
easier access to the configured slaves.

For each EtherCAT slave device, the station address and name of the
slave will be displayed. Items, which are deactivated, are present in the tree
structure, but the description text is displayed in red color.

Configurable slaves with respect to CoE are marked with a check mark
(indicated in green color). If you select the master or a slave which has not
been checked, then the lower part of the dialog pane will be simply grey
and the text “No CoE configuration needed” will appear in the center of this
area:

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Configuration 68/145

Figure 46: Mailbox > CoE:

Otherwise, the following will happen:
· The station address and name of the selected EtherCAT Slave device

will be displayed
· A register consisting of 3 register cards will appear:

General
Start-up
Userdef start-up
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6.5.1.1 General

The general page displays some important general information concerning
mailboxes. In detail, these are:
· The Sync Manager Channel Number of the Input Mailbox,
· the Sync Manager Channel Number of the Output Mailbox,
· the size of the Input Mailbox and the Output Mailbox.

Figure 47: Mailbox > CoE, 'General' Register Card
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6.5.1.2 Start-up

The start-up page allows to specify which data should be written into the
EtherCAT object dictionary of the selected device (whose station address
and name are displayed at the top of the register card) when particular
changes of state of the EtherCAT device take place.

In detail, the following information may be specified

Transition

The transition, which triggers the write access to the object dictionary.

Index and subindex

Index and subindex are used for addressing objects within the object
dictionary. Refer to the EtherCAT specification for more information about
the object dictionary.

Data

The data to write to the location specified using index and subindex within
the object dictionary upon occurrence of the specified transition. The length
depends on the chosen index and subindex.

Comment

Description of start-up command.

Note:
A key symbol in front of the line denotes a fixed startup command.

Figure 48: Mailbox > CoE, 'Start-up' register card
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6.5.1.3 User defined, start-up

Similarly, the ‘Userdefined start-up’ page allows to specify data to be
written to a specific location within the object dictionary addressed by index
and subindex triggered by a transition that also can be explicitly specified.
Again, a comment can be added to the entry.

Transition

You can select which transition triggers the write access to the object
dictionary. by marking the corresponding check box. The following state
transitions are available to be chosen as triggering event for writing into the
object dictionary:
State transition Description
I2P Init state to Pre-Operational State
P2S Pre-Operational State to Safe-Operational State
S2P Safe-Operational State to Pre-Operational State
O2S Operational State to Safe-Operational State
S2O Safe-Operational State to Operational State

Table 21: Mailbox > CoE, 'Start-up' register card, description of the state transitions

Note:
It is also possible to mark more than one check box to trigger the
same action by separate state transitions.

· SDO (Index and subindex)
The SDO input area is used to specify which index and subindex should
be used for addressing the desired object within the object dictionary.

· The index is specified hexadecimally within the left field of the SDO
input area. At maximum 4 positions can be specified here for input.

· The sub-index is specified decimally within the right field of the SDO
input area. At maximum 3 positions can be specified here for input.
Refer to the EtherCAT specification or the EtherCAT Protocol API
Reference Manuals for more information about the object dictionary.

· Data
The data to write to the location specified using index and subindex
within the object dictionary upon occurrence of the specified transition.
The length depends on the chosen index and subindex.
You may specify a string here as it is converted if necessary.

· Comment
Description of start-up command.

Add CoE Start-up Command Button

You have to click this button to add a newly defined SDO to the list of start-
up commands shown in page ‘Startup’.

If the data are not correctly entered in hexadecimal format at ‚Add CoE
Start-up’, the following error message box will be displayed:
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Figure 49: Error message box at incorrect Input of Init Command Data

Note:
Omit the leading ‚0x’ when entering hexadecimal data ‚Add CoE
Start-up’. Otherwise, this message box might also be displayed.

If at ‚Add CoE Start-up’ no transition at all has been specified, the following
error message box will be displayed:

Figure 50: Error message box at incorrect Input of Init Command Data
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‘Load Object Dictionary from DDF’ Button

The object dictionary can be loaded from the Device Description XML file if
available and displayed here. Objects can be directly selected from the
dictionary for further editing of its data and comment and for defining
transition states for its transfer!

The list box in the lower part of the register card may contain a part of the
contents of the object dictionary.

Figure 51: Mailbox > CoE, 'Userdef Start-up' register card
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6.6 FMMU/Sync Man

6.6.1 FMMU and SyncMan
The FMMU/ Sync Man dialog pane displays a combined view of all
Fieldbus Memory Management Units defined in the EtherCAT Master
configuration together with the associated sync managers. All values
shown here cannot be edited. To access the dialog pane:
Ø Select FMMU / Sync Man in the navigation area.

Figure 52: Configuration > FMMU/ SyncMan

The upper part of the dialog pane displays a table containing information
related to the Fieldbus Memory Management Units.

Note:
The contents of this table can be sorted in ascending (arrow
upwards) or descending order (arrow downwards) of the following
columns by clicking once or twice at the respective column head:
Station address, L start, Length, L EndBit, P start, Sm
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A Fieldbus Memory Management Unit, shortly FMMU, provides a mapping
between logical addresses within the EtherCAT network on one hand and
physical addresses on the various slaves within the EtherCAT network on
the other hand.

EtherCAT supports combining information from multiple slaves even within
one single data telegram. This central feature of EtherCAT is achieved by
the use of the FMMU logically mapping physical addresses from different
slaves into one combined space of memory.

The FMMU provides up to 16 FMMU channels depending on the device.
Each FMMU channel defines a specific memory assignment (denominated
as memory translation) between a contiguous area of logical memory of the
EtherCAT network and another contiguous area of physical memory of the
slave device.

Aim of this concept is mapping any memory area within an EtherCAT slave
to any logical memory area within the address space of the EtherCAT
network . bit-wise mapping is supported.

Parameter Description Range of Value / Default
Value

Station Address This parameter denotes the station address which has been
assigned to the EtherCAT slave by the master at initialization and
which has been stored in the configured station address register of
the slave.

0-65535/None

Logical Start Address This parameter contains the byte address in the logical memory
area of the memory translation where the contiguous area to be
mapped starts.

0-232-1/None

Length This parameter contains the size in bytes of the translated memory
area.

0-65535/None

Logical End Bit This parameter contains the bit offset of the logical end address,
i.e. the address where the contiguous memory area ends.

0-255/None

Physical Start Address This parameter contains the byte address in the physical memory
area of the memory translation where the contiguous area to be
mapped starts.

0-65535/None

Flags See explanations just below. True or false/None
Sync Manager Number of sync manager, see explanation below 0-31/None
Sync unit Sync unit

Table 22: FMMU-related information

The flags each stored within a single bit of its own have the following
meaning:
· Read Enable

This flag contains the information whether a read operation is currently
allowed, or not. If set to 1, reading will be enabled, otherwise disabled.

Note:
A read operation in this context denotes a data transfer where the
physical memory is the source and the logical memory is the
destination.
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· Write Enable

This flag contains the information whether a write operation is currently
allowed, or not. If set to 1, writing will be enabled, otherwise disabled.

Note:
A write operation in this context denotes a data transfer where the
logical memory is the source and the physical memory is the
destination.

· Channel Enable

This flag contains the information whether the memory translation defined
in the channel is currently active, or not. If set to 1, writing will be enabled,
otherwise disabled.

The lower part of the dialog pane displays a table containing information
related to the sync managers.

Note:
The contents of this table can be sorted in ascending (arrow
upwards) or descending order (arrow downwards) of the following
columns by clicking once or twice at the respective column head:
Station address, Channel, Start Address, Length, Buffer Type,
Access

According to the EtherCAT specification, the main task of a sync manager
is the coordination of access to concurrently used objects.

In order to perform this coordination task, a sync manager is organized as a
collection of control elements; these are usually denominated as channels.

A sync manager channel defines a consistent area of application memory.
Parameter Description
Station Address This parameter denotes the station address which has been assigned to the EtherCAT slave by the

master at initialization and which has been stored in the configured station address register of the
slave.

Channel Channel number (Allowed range of values: 0...3)
Start Address This parameter contains the start address of the consistent application memory area.
Length This parameter contains the size of the consistent application memory area (specified in bytes).
Buffer Type This parameter contains the information whether the access type to the consistent application

memory area is queued or buffered.
Access This parameter contains the information if the consistent application memory area is read or written

by the master.
Watchdog This parameter contains the information if the monitoring of an access to the consistent application

memory area is enabled. Values are Enabled and Disabled.
Master This parameter may contain additional data associated with the EtherCAT Master.

Table 23: SyncManager-related information

The connection used for logically joining the FMMU channels to the sync
manager channels is the station address.
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6.7 Process data
For the EtherCAT Master DTM the Process data pane serves as an
external process data interface, e. g. for data transfer to a PLC unit. The
process data pane lists the slave devices connected to the master, as well
as the configured modules or input or output signals of the devices. This
makes the fieldbus structure visible.

For the configured modules, submodules or measuring signals names
(tags) can be set (column "Tag").

In addition, it can be specified which signal data is to be made available on
the OPC server (column SCADA).

Figure 53: Process data (*display device name)

Column Symbol Description
Type  Device Device labeling* provided by the hardware followed by the device’s name of station in

pointy brackets

 module,
submodule

 I/O signal

Description of the modules, submodules or input or output signals configured on the
device (not editable)

Tag  Device Symbolic name* of the device

 module,
submodule

 I/O signal

Symbolic name for the modules, submodules or input or output signals configured on the
device (editable)

 warning Duplicate Tag at the same level can cause errors by use of OPC!
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Column Symbol Description
SCADA Selection option which module, submodule or signal data should be made available on the OPC server.

„SCADA“ (= Supervisory Control and Data Acquisition), 
here used with the meaning „to provide for visualizing purposes“.

*Depending on the protocol, either the device name or the symbolic name can be edited via the device symbol context
menu.

Table 24: Process data
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6.8 Address table
The Address table dialog pane shows a list of all addresses used in the
process data image. The displayed addresses refer to the used EtherCAT
Master.

To configure the address data:
Ø Select Configuration > Address table in the navigation area.

Figure 54: Configuration > Address Table (Example)

Parameter Description
Device Descriptive name of a device
Station address The station address having been assigned to the EtherCAT Slave by the master at initialization

and which has been stored in the configured station address register of the slave.
PDO index Index of Process Data Object within object dictionary

PDO name Name of Process Data Object
PDO-Entry index Index of Process Data Object Entry within object dictionary
PDO-Entry name Descriptive name of Process Data Object Entry
Type Data type (such as integer or Boolean).
Address Address
Length Length in bytes or bits (if specified after decimal point).

Table 25: Address table pane parameters - inputs / outputs
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Use Display mode  to select data
display mode decimal or hexadecimal.

The CSV export option allows to export input- and output addresses as
CSV file (CSV = comma separated value). Therefore:
Ø Click to the CSV export button.
Ê A file saving dialog opens.
Ø Save the data as *.CSV file.

You can open the generated data by means of a spreadsheet application.

Sort addresses
Ø To sort the address data, click on the respective column header.
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6.9 Init commands
The ‘Init commands dialog pane allows to display a sequence of
initialization commands.
Ø Select Configuration > Init commands in the navigation area.

Figure 55: ‘Init Commands’ page

The upper part of the ‘Init Commands’ dialog pane displays the structure of
the EtherCAT network in a very similar manner as the ‘Topology>TreeView’
page does. The only relevant difference is the absence of the project item,
so only the master and all of its slaves are present in this structure tree of
the EtherCAT network.

The lower part of the ‘Init Commands’ dialog pane displays:
· The long form of the name of the selected EtherCAT (master or slave)

device.
· The heading ‘Init Commands’

Note:
In case a slave has been selected for display, the station address
uniquely identifying this slave. This is displayed directly subsequent
to the heading ‘Init Commands’.

· A table indicating the sequence of command execution and the
dependence from state transition of the device’s EtherCAT state
machine.
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· An area containing some fields displaying the parameters of the
selected command.

The table shows the sequence how the commands are executed and the
information at which state transitions this happens. For each command the
following information is displayed:
· Whether the command should be executed at 9 specific state transitions

(first 9 columns)
· The command code
· A comment (short text describing the intention of the command)

These 9 state transitions are in this sequence:
· Init to Pre-Operational
· Pre-Operational to Init
· Pre-Operational to Safe- Operational
· Safe- Operational to Pre-Operational
· Safe- Operational to Init
· Safe- Operational to Operational
· Operational to Safe- Operational
· Operational to Pre-Operational
· Operational to Init

Possible command codes are:
Command code Description
APRD Auto-Increment Read
APWR Auto-Increment Write
NPRD Node-addressed Physical Read
NPWR Node-addressed Physical Write
BRD Broadcast Read
BWR Broadcast Write
LRD Logical Read
LWR Logical Write

Table 26: Possible command codes in Init commands

For more information on this topic see section 7.1.3 “EtherCAT
telegram structure” of the EtherCAT specification, version 1.0, on
page 70.
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The parameter area contains the following items:
Parameters Description
Command code The command code of the selected line (one of the codes from the table just above)
ADP This numeric parameter contains the configured station address.
ADO This numeric parameter contains the physical memory address
New Cycle An Boolean parameter whether a new cycle should be started.
New Frame An Boolean parameter whether a new frame should be started.
Size The size of the command.
Timeout The timeout value valid for the command
Retries The valid retry limit for the command (i.e. the maximum number of allowed retries)
Validate Validation data
Mask A mask indicating which bits are valid.
Data The relevant data.

Table 27: Parameters of EtherCAT command

DTM for Hilscher EtherCAT Master devices | Configuration of Hilscher master devices
DOC090404OI12EN | Revision 12 | English | 2023-06 | Released | Public

© Hilscher 2008 – 2023



Configuration 84/145

6.10 Connecting/disconnecting device

Note:
Several EtherCAT Master DTM functions, e. g. diagnosis or the
configuration download in SYCON.net, require an online connection
from the EtherCAT Master DTM to the EtherCAT Master device.

Connecting device

To establish an online connection from the EtherCAT Master device to the
EtherCAT Master DTM, take the following steps:

Under Settings in the Driver pane:
Ø Verify that the default driver is checked and respectively check another

or multiple drivers.
Ø Configure the driver if necessary.

Under Settings in the Device assignment pane:
Ø Scan for the devices (with or without firmware).
Ø Select the device (with or without firmware) and apply the selection.

Before you download the firmware, adhere to the necessary safety
precautions to prevent personnel injury and property damage that may
occur in consequence of a communication stop. For further details, please
refer to the Safety chapter.

Under Settings in the Firmware download pane, if not yet a firmware was
loaded to the device:
Ø Selecting and downloading the firmware.

Under Settings in the Device assignment pane, if not yet a firmware was
loaded to the device:
Ø Scan for the device (with firmware) once more.
Ø Select the device (with firmware) once more.

For more information, see sections on driver settings and device
assignment.
Ø In the DTM interface dialog, select the OK button, to apply the selection

and to close the DTM interface dialog.
Ø Right-click on the EtherCAT Master icon.
Ø Select Connect from the context menu.
Ø The EtherCAT Master device now is connected to the EtherCAT Master

DTM via an online connection. In the network view, the device
description at the device icon is displayed with a green colored
background.
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Disconnecting device

To disconnect an online connection from the EtherCAT Master device to
the EtherCAT Master DTM, take the following steps:
Ø Right-click on the EtherCAT Master icon.
Ø Select Disconnect from the context menu.
ð In the network view, the device description is not any more displayed

with a green colored background. Now the online connection from
EtherCAT Master device to the EtherCAT Master DTM.
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6.11 Download configuration
The device configuration is created "offline" in the DTM (application
program). A download to the device is required, to transfer the configuration
with the parameter data to the device.

Note:
To download configuration parameter data to the EtherCAT Master
device an online connection from the EtherCAT Master DTM to the
EtherCAT Master device is required. Further information can be
found in Connecting/disconnecting device [} page 84].

 Communication stop caused by configuration download,
faulty system operation possible or loss of device parameters

Before you initiate a configuration download process, while the bus is still in
operation status:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

 Mismatching system configuration, faulty system or
device operation possible
Ø In the device, use only a configuration suitable for the system.

 Loss of device parameters caused by power disconnect
during configuration download
Ø During configuration download process, do not interrupt the power

supply to the PC or to the device, and do not perform a reset to the
device!

Download steps

In order to transfer the configuration with the corresponding data of the
configuration parameters to the EtherCAT Master device, download the
data via Device > Download or context menu Download.
Ø Select Download in the context menu of the device.
Ê If the download is started as long as the slave devices are connected to

the master device, the following message is displayed: "If you attempt to
download during bus operation, communication between master and
slaves is stopped. Do you really want to download?"

Figure 56: netDevice Message: Download
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Important:
If the communication between the master device and the slave
devices is stopped, the data exchange between the master device
and the slave devices is stopped.

Ø Click Yes if you intend to download the configuration.
Ê Then the current configuration in the application program is down

loaded to the device.
Ø Otherwise click to No.
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6.12 Network scan
With the function Network scan... of the EtherCAT Master DTM you can
find out automatically which EtherCAT Slave device are attached to the
EtherCAT Master device and how these devices are configured. During the
network scan the master device requests the ident codes of the slave
devices found at the bus. For each connected master device, its ident code
is read out.

In the Scan response dialog of the master DTM the assigned device
description files or DTM devices are displayed. Exactly one ident code is
assigned to each device description file and to each DTM device. Different
versions (also language versions) of the same device description file are
defined by the same ident code. For each identified device, you can select
the assigned DTM device according to the firmware loaded in that slave
device. Via Create devices for each slave device, the selected DTM device
is created.

6.12.1 Requirements
The EtherCAT Master device must be configured.

Important:
The configuration of the master device must be loaded into the
master device. For further information, see section Configuration
steps [} page 15].

6.12.2 Overview on steps
1. Start the Network scan (in the master DTM).
2. Make the settings in the Scan response dialog.
3. Click Create devices.
4. Via Download, download the current configuration of the slave devices

to the master device.
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6.12.3 Starting network scan
Ø In netDevice: Right-click on the device symbol of master DTM.
Ø Select Network scan... from the context menu.

Figure 57: Starting ‘Network scan’ (example)

Ø Wait for a moment.

Note:
It may take a few seconds to display the Scan response dialog of
the EtherCAT Master DTM.

Ø Via Network scan... an online connection from the EtherCAT Master
DTM to the EtherCAT Master device is established. SYCON.net scans,
which EtherCAT Slave devices are connected to the network or the
EtherCAT Master device.

ð The Scan response dialog of the master DTM appears.
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Figure 58: Scan response dialog of the master DTM (example)
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6.12.4 Scan response dialog settings
Ø Make the settings in the Scan response dialog of the EtherCAT Master

DTM.
Ê In the DTM device column the DTM devices assigned to the found ident

codes appear.

Figure 59: Scan response dialog of the EtherCAT Master DTM (example)

Ø In the DTM device column, select for every identified device the DTM
device corresponding to the firmware loaded in this EtherCAT Slave.

· If in the DTM device column no DTM device or a DTM device not
desired is displayed, add the required DTM devices to the device
catalog.

· Or adapt the creation mode under Creation mode.
Ø In the Action column select, whether the found DTM device shall be:
· added or skipped 

(if a device is not yet present in the project),
· or replaced or skipped 

(if a device is already present in the project).
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6.12.5 Scan response dialog
In the following table, you find a description about the Scan response
dialog of the EtherCAT Master Master DTM.

Column Description
Title bar With the text: "Symbolic Name [Device description] (#Network ID) channel/[Name of the network]". It

is the symbolic name of the EtherCAT EtherCAT Master device.
Instruction In the Network Scan window, the instruction text is displayed: The following hardware-devices

have been found during network scan. Please check automatic selection of corresponding
devices found in device catalog in column ‘DTM devices’ before creating devices.

Station address EtherCAT station address, which displays the logical sequence of the devices within a EtherCAT
network.

Colors Meaning of colors in the Scan response dialog of the EtherCAT Master DTM:
If a field marked in red appears in column Station address, the respective DTM device is
already present on the network.
If a field appears marked in yellow, a selection can be made by a combo box.

Device type ID Identification (ID): Ident code read out from each device (Unique Identifier)
Sub device type Sub-device type of the device type, if applicable (not used in PROFIBUS).
DTM to use Display of the DTM devices, which are assigned to the ident codes found during scanning: 

If  is displayed without color marking, there is no selection
possibility. 
If  is displayed marked in yellow, the following selection can be
made: 

(In the figure shown example DTMs are displayed.) A selection will only be displayed if under
Creation Mode > Choose for each device was selected and if another DTM has been found for the
respective device.
A selection will only be displayed if under Creation mode > Choose for each device was selected
and if another DTM has been found for the respective device.

Device class Device class of the EtherCAT Slave device.
DTM device Found DTM device (the device name as taken from the DTM). 

Only the device description files or DTM devices can be displayed within the column DTM devices:
· Which are available in the device catalog for the scanned ident code,
· Respectively, which belong to the selection made under Creation mode
· and which belong to the selection made under Creation mode > Choose for each device under

DTM to create.
For each device type ID in the
column DTM device the following
is displayed:
· no device,
· one single device

· or multiple devices 
(within a combobox).

This means, within the device catalog of netDevice for the found
ident code and the selected Creation mode these alternatives
are available:
· no DTM,
· a device description file respectively a DTM device of a

manufacturer,
· or one or more device description files respectively a DTM

devices of a manufacturer.
Quality Associated quality information 

Display: [1] DTM found, [3] Generic found
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Column Description
Action The action to be performed with the corresponding device during the process of device creation.

· If no device is present within the current project, the selection Add/Skip will appear.
· If there is already a device present within the current project, the selection Replace/Skip will

appear.
Add adds during the device creation process a new instance for the selected DTM to the newly
found device address.
Skip skips the device creation process for the respective device address.
Replace erases the instance of the DTM currently located at this address during the device creation
process, and replaces it with the instance of the chosen DTM.

Table below
The lower table in the Scan response dialog of the EtherCAT Master DTM shows a comparison of
possible differences in device information taken from:
· The hardware device (displayed in central column of 3)
· and the DTM (displayed in right column of 3)
The left column contains which information is compared between the information sources "Hardware
Device" and "DTM".
Note! If a field contains the text ‘n/a’, the corresponding information is not applicable in the current
context (fieldbus).

Creation mode Under Creation mode one of the following options can be selected:
· Use Hilscher generic DTM if available
· Use vendors DTMs if available
· Choose for each device
Scan response dialog of the EtherCAT Master DTM > "Creation mode"

Create devices About Create devices...
· for each EtherCAT Slave device the previously selected DTM device is created.
· the EtherCAT Slave device configuration is uploaded to the created EtherCAT Slave DTM and

thereby the module configuration is generated.
In case a conflict occurs between a device description file and a device, the Upload dialog appears
where conflicts are displayed in red.

Cancel Click Cancel to leave the dialog without creating a device.
Table 28: Description on the Scan response dialog of the EtherCAT Master DTM

6.12.6 Creating devices
Ø In the Scan response dialog of the EtherCAT Master DTM click Create

devices.
Ê For each EtherCAT Slave device the previously selected DTM device is

created.
Ê The dialog netDevice appears showing the progress bar Creating DTM

Device. The dialog shows the progress of the device creating process.

Note:
Depending on the manufacturer of the respective device, also a
dialog with some slight deviations from this one may be displayed.
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Figure 60: Creating the DTM devics (Example)

ð The generated EtherCAT Slave devices are added to the master bus in
the network.

Figure 61: Created EtherCAT Slave devices in the network (Example)

6.12.7 Downloading configuration

Safety precautions

Adhere to the necessary safety precautions to prevent personnel injury and
property damage. For further details, please refer to the Safety chapter.
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How to proceed

Via the Download function of the EtherCAT Master DTM, download the
current configurations of the EtherCAT Slave devices to the EtherCAT
Master device.
Ø In netDevice: right-click on the device symbol of the DTM.

Figure 62: ‚Download’ current Configuration to the EtherCAT Master device (Example)

Ø Select Download from the context menu.
Ê The Dialog netDevice - Download appears: “If you attempt to

download during bus operation, communication between master and
slaves is stopped. Do you really want to download?”

Ø Click Yes.
Ê The dialog netDevice appears showing the progress bar Download

active, device performs initialisation….
ð The netDevice window shows the message (example): “Download

succeeded to device CIFX_RE_ECM[CIFX_RE/ECM]<1>(1#).”
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6.13 Online comparison
SYCON.net offers the possibility to compare online between the configured
devices and the scanned devices on the other hand.

Online connection to the device

Note:
Accessing the online comparison dialog panes of the EtherCAT
Master DTM requires an online connection from the EtherCAT
Master DTM to the EtherCAT Master device device. For further
information refer to section Connecting/disconnecting
device [} page 84].

To access the online comparison of the topology:
Ø Select Online comparison in the navigation area.
Ê A “split screen” display appears allowing to precisely compare:
· The device information stored in the configuration of SYCON.net on the

left half of the window.
· The device information scanned from the network presented on the right

half of the window.

Figure 63: Online comparison (before pressing button 'Compare online')
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At the bottom you find a button “Compare online'” In order to start the
comparison process between the configuration information stored internally
in SYCON.net and the current configuration information derived by an
EtherCAT network scan, proceed as follows:
Ø Click at the button Compare online, which you can find at the bottom of

the window.
Ê The text in the button will immediately change to Stop process then.

The display will look like this:

Figure 64: Online comparison (after pressing button “Compare online”

In order to stop the comparison process described above:
Ø Just click the button Stop process again.
Ê The comparison process will be interrupted.

The information, which is displayed for each device, may include:
· The Vendor ID
· The Product Code
· The Revision number
· Information on previously used ports

Information items differing between configuration and network scan are
displayed in red. If the results are equal, they are displayed by black text.
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In front of the name of the respective slave device additional information
can be displayed. The meaning is:
Sign Description

A red x indicates that the configured devices could not be discovered on
the bus.

No sign at all The configured device exactly matches the scanned information about
the device in the same position, i.e. the position addresses are equal.
The configured device matches the scanned information about the
device, but in a different position, i.e. the position addresses are not
equal. Both values are displayed separated by a colon (for instance, 2.3
means, the device configured at position 2 could be found by the
network scan, but under position 3)
A red exclamation mark indicates a slave has been discovered by the
network scan, which has not been configured at all. This can only
appear on the right part of the screen.

Table 29: Description of signs in cnline comparison
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7 Diagnosis

7.1 Overview diagnosis
The dialog Diagnosis serves to diagnose the device behavior and
communication errors. For diagnosis, the device must be in online state.

Figure 65: Navigation area - Diagnosis

Online connection to the device

Note:
Accessing the Diagnosis panes of the EtherCAT Master DTM
requires an online connection from the EtherCAT Master DTM to
the EtherCAT Master device. For further information refer to section
Connecting/disconnecting device [} page 84].

How to proceed
Ø In the diagnosis dialog, check whether the communication is OK:

Diagnosis > General diagnosis > Device status "Communication"
must be green!

Ø "Communication" is green: Open the IO monitor and test the input or
output data.

Ø "Communication" is not green: Use Diagnosis and Extended
diagnosis for troubleshooting.

Extended diagnosis

The Extended diagnosis helps to find communication and configuration
errors, when default diagnosis fails.
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7.2 General diagnosis
Information regarding the Device State and other general diagnosis
parameters are displayed in the General Diagnosis dialog.

Figure 66: General diagnosis

LED Description Color State
Device state

Communication Shows whether the EtherCAT device executes the
network communication.

 (green) In COMMUNICATION state

 (gray) Not in COMMUNICATION
state

Run Shows whether the EtherCAT device has been
configured correctly.

 (green) Configuration OK

 (gray) Configuration not OK

Ready Shows whether the EtherCAT device has been
started correctly. The EtherCAT device waits for a
configuration.

 yellow Device READY

 (gray) Device not READY

Error Shows whether the EtherCAT device records a
device status error. For further information about
the error characteristics and the number of counted
errors refer to the extended diagnosis.

 (red) ERROR

 (gray) No ERROR

Network state
Operate Shows whether the EtherCAT device is in data

exchange. In a cyclic data exchange the input data
or the output data of the EtherCAT Master is
transmitted to the EtherCAT Slave.

 (green) In OPERATION state

 (gray) Not in OPERATION state

Idle Shows whether the EtherCAT device is in data
exchange. The connection establishment between
EtherCAT Master and EtherCAT Slave is in
progress.

 (yellow) In IDLE state

 (gray) Not in IDLE state

Stop Shows whether the EtherCAT device is in Stop
state: There is no cyclic data exchange at the
EtherCAT network. The EtherCAT device was
stopped by the application program or it changed to
the Stop state because of a bus error.

 (red) In STOP state

 (gray) Not in STOP state
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LED Description Color State
Offline The EtherCAT Master is offline as long as it does

not have a valid configuration.
The EtherCAT Slave does not have a valid
configuration.

 (yellow) In OFFLINE state

 (gray) Not in OFFLINE state

Configuration state
Configuration
locked

Shows whether the EtherCAT device configuration
is locked, to avoid the configuration data is typed
over.

 (yellow) Configuration not LOCKED

 (gray) Configuration not LOCKED

New
Configuration
pending

Shows whether a new EtherCAT device
configuration is available.

yellow New configuration pending

 (gray) No new Configuration
pending

Reset required Shows whether a firmware reset is required as a
new EtherCAT device configuration has been
loaded into the device.

yellow RESET required

 (gray) No RESET required

Bus ON Shows whether the bus communication was started
or stopped. I. e., whether the device is active on the
bus or no bus communication to the device is
possible and no response telegrams are sent.

 (green) Bus ON

 (gray) Bus OFF

Table 30: Indication general diagnosis

Parameter Description
Communication
error

Shows the name of the communication error. If the cause of error is resolved, the value will be set
to zero again.

Watchdog time Shows the watchdog time in ms.
Error count This field holds the total number of errors detected since power-up, respectively after reset. The

protocol stack counts all sorts of errors in this field no matter whether they were network related or
caused internally.

Table 31: Indication general diagnosis
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7.3 Master diagnosis
Information regarding the slave state, slave errors and slaves configured,
active or in diagnostic is displayed in the Master Diagnosis dialog.

Figure 67: Master diagnosis

Parameter Description Range of value /
value

Slave state Shows whether slave state is ok or not.
The slave state field for master diagnosis shows whether the master is in cyclic
data exchange to all configured slaves. In case there is at least one slave
missing or if the slave has a diagnostic request pending, the status will be set to
FAILED. For protocols that support non-cyclic communication only, the slave
state is set to OK as soon as a valid configuration is found.

UNDEFINED, OK,
FAILED

Slave error log
indicator

Shows whether the slave error log indicator is available.
The error log indicator field holds the number of entries in the internal error log. If
all entries are read from the log, the field will be set to zero.

EMPTY,
AVAILABLE

Configured
slaves

Shows the number of configured slaves.
Number of configured slaves in the network according to the slave list derived
from the configuration database created by the configuration software. The list
includes the slaves to which the master has to open a connection.

Active slaves Shows number of active slaves.
Number of slaves in data exchange mode. The list includes the slaves to which
the Master has successfully opened a connection

Slaves with
diagnostic

Shows number of slaves with diagnostic.
Number of slaves with diagnosis or error slaves.

Table 32: Parameters Master diagnosis
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7.4 Station diagnosis

Figure 68: Station diagnosis

The Station diagnosis shows the status for all EtherCAT Slave device,
which are configured in the EtherCAT Master. The EtherCAT Master DTM
updates this display cyclically.

Column Description Value range / value
Status The status of the device addressed under the displayed station

address.
Running, Diagnosis,
Not found, Error

Station address Station address under which the device is addressed. Valid station
address

Auto increment address Addressing of the slave devices based on their physical order.
Slave name Name of the device assigned to the displayed station address. 1 - 240 characters

Table 33: Columns of the Station diagnosis table

The legend below describes the possible values for the state of a device,
which is assigned to a station address.

Color Name Description
green Running The device associated with this station address is running.
yellow Diagnosis Diagnosis is available for the device associated with this station address.
blue Not found The device associated with this station address was parameterized, but not found.
red Error An error message is available for the device associated with this station address.

For the status ,error' additionally a textual error messages can appear.
Table 34: Possible values for the status
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7.5 Firmware diagnosis
In the dialog Firmware Diagnosis, the current task information of the
firmware is displayed.

Under Firmware or Version the name of the firmware and version
(including the date) are indicated.

Figure 69: Firmware Diagnosis

Task information:

The table Task Information is listing the task information of the single
firmware tasks.
Task Description
Task Name of task
Name of task Name of the task
Version Version number of the task
Prio Priority of the task
Description Description of the task
Status Current status of the task

Table 35: Description table task information
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8 Extended diagnosis

8.1 Overview extended diagnosis
The "Extended Diagnosis" of the EtherCAT Master DTM helps to find
communication and configuration errors, when default diagnosis fails.
Therefore, it contains a list of diagnosis structures as online counter, states
and parameters.

The table below gives an overview for the extended diagnosis dialog panes
descriptions of the EtherCAT Master DTM:

Folder name / Section Subsection
different folders Task information [} page 106]
RX-SYSTEM IniBatch status [} page 107]
ECAT_MASTER Low level error counter [} page 108]

Packet counter stack [} page 109]
Internal status stack [} page 110]

ECAT_MASTER_AP Packet counter AP task [} page 111]
DPM statistics [} page 113]
Internal status of AP task [} page 114]

Table 36: Descriptions of the dialog panes extended diagnosis

Note:
Accessing the Extended Diagnosis dialog panes of the EtherCAT
Master DTM requires an online connection from the EtherCAT
Master DTM to the EtherCAT Master device. For further
information, refer to section Connecting/disconnecting
device [} page 84].
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8.2 Task information

Figure 70: Extended Diagnosis > [Folder Name] > Task Information Example Display

Name Description
Identifier Identification number of the task
Major version Task version, contains incompatible changes
Minor version Task version, contains compatible changes
Maximum packet size Maximum packet size, which the task sends
Default Queue Queue handle, which is accessible via DPM by mailbox.
UUID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g. to a

stack (therein different identification data is coded in).
Init result Error Code, 0= no Error

The description of the error codes can be found in this manual or in the corresponding
software reference manuals.

Table 37: Extended Diagnosis > [Folder Name] > Task Information
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8.3 IniBatch status

Figure 71: Extended Diagnosis > [Folder name] > IniBatch Status example display

Name Description
Communication Channel Number of the communication channel used by the device.
Current State Idle; 

IniBatch packets in progress; 
Retrying to send last packet; 
Error

IniBatch Result Ok; 
No DBM file; 
No Packet table; 
No data set available; 
Data set is shorter than packet length; 
Packet Buffer is shorter than Packet length; 
Invalid packet destination; 
Logical queue not defined Send packet failed; 
Too many retries; 
Error in confirmation packet status

OpenDbm Result Error when opening the IniBatch database 
Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM
file" (1) is.

SendPacket Result Error when sending a packet 
Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send
packet failed" (8) is.

Confirmation Result Confirmation error when sending packets
Under "Confirmation Result" the packet specific error code from the ulSta is typed in,
when "IniBatch Result " == "Error in confirmation packet status" (10) is.

Last Packet Number Value depends by the communication system.
Last Packet Command Value depends by the communication system.
Last Packet Length Value depends by the communication system.
Last Packet Destination Value depends by the communication system.

Table 38: Extended Diagnosis > [Folder name] > IniBatch Status

The task status "Confirmation Result" is bus specific. The other task status
are rcx-related error codes.
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8.4 ECAT_MASTER

8.4.1 Low level error counter

Figure 72: Extended diagnosis > ECAT_MASTER > Low level error counter

Name Description
CYCCMD_WKC_ERROR counter Counter for CYCCMD_WKC_ERROR
MASTER_INITCMD_WKC_ERROR counter Counter for MASTER_INITCMD_WKC_ERROR
SLAVE_INITCMD_WKC_ERROR counter Counter for SLAVE_INITCMD_WKC_ERROR
EOE_MBXRCV_WKC_ERROR counter Counter for EOE_MBXRCV_WKC_ERROR
COE_MBXRCV_WKC_ERROR counter Counter for COE_MBXRCV_WKC_ERROR
FOE_MBXRCV_WKC_ERROR counter Counter for FOE_MBXRCV_WKC_ERROR
EOE_MBXSND_WKC_ERROR counter Counter for EOE_MBXSND_WKC_ERROR
COE_MBXSND_WKC_ERROR counter Counter for COE_MBXSND_WKC_ERROR
FOE_MBXSND_WKC_ERROR Counter for FOE_MBXSND_WKC_ERROR
FRAME_RESPONSE_ERROR Counter for FRAME_RESPONSE_ERROR
SLAVE_INITCMD_RESPONSE_ERROR Counter for SLAVE_INITCMD_RESPONSE_ERROR
MASTER_INITCMD_RESPONSE_ERROR counter Counter for MASTER_INITCMD_RESPONSE_ERROR
CMD_MISSING counter Counter for CMD_MISSING
MBSLAVE_INITCMD_TIMEOUT counter Counter for MBSLAVE_INITCMD_TIMEOUT
NOT_ALL_DEVICES_OPERATIONAL counter Counter for NOT_ALL_DEVICES_OPERATIONAL
ETH_LINK_NOT_CONNECTED counter Counter for ETH_LINK_NOT_CONNECTED
CYCCMD_TIMEOUT counter Counter for CYCCMD_TIMEOUT
RED_LINEBRK counter Counter for RED_LINEBRK
STATUS_SLAVE_ERROR counter Counter for STATUS_SLAVE_ERROR
SLAVE_ERROR_STATUS_INFO counter Counter for SLAVE_ERROR_STATUS_INFO
SLAVE_NOT_ADDRESSABLE counter Counter for SLAVE_NOT_ADDRESSABLE

Table 39: Extended diagnosis > ECAT_MASTER > Low level error counter
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8.4.2 Packet counter stack

Figure 73: Extended diagnosis > ECAT_MASTER > Packet counter stack

Name Description
ulEthercatMasterCmdRegisterAtStackReq Counter for ulEthercatMasterCmdRegisterAtStackReq
ulEthercatMasterCmdSetBusparamReq Counter for ulEthercatMasterCmdSetBusparamReq
ulEthercatMasterCmdBusOnReq Counter for ulEthercatMasterCmdBusOnReq
ulEthercatMasterCmdBusOffReq Counter for ulEthercatMasterCmdBusOffReq
ulEthercatMasterCmdHostWdgTimeoutReq Counter for ulEthercatMasterCmdHostWdgTimeoutReq
ulRcxGetSlaveHandleReq Counter for ulRcxGetSlaveHandleReq
ulRcxGetSlaveConnInfoReq Counter for ulRcxGetSlaveConnInfoReq
ulConfigurationReloadReq Counter for ulConfigurationReloadReq
ulEthercatMasterCmdUpdateCommunicationStateRes Counter for

ulEthercatMasterCmdUpdateCommunicationStateRes
ulEthercatMasterCmdUpdateGlobalSlaveInfoRes Counter for

ulEthercatMasterCmdUpdateGlobalSlaveInfoRes
ulUnknownCommandReq Counter for ulUnknownCommandReq
ulEthercatMasterCmdSdoUploadReq Counter for ulEthercatMasterCmdSdoUploadReq
ulEthercatMasterCmdSdoDownloadReq Counter for ulEthercatMasterCmdSdoDownloadReq
ulEthercatMasterCmdGetOdListReq Counter for ulEthercatMasterCmdGetOdListReq
ulEthercatMasterCmdGetObjectDescReq Counter for ulEthercatMasterCmdGetObjectDescReq
ulEthercatMasterCmdGetEntryDescReq Counter for ulEthercatMasterCmdGetEntryDescReq
ulEthercatMasterCmdReadEmergencyReq Counter for ulEthercatMasterCmdReadEmergencyReq
ulEthercatMasterCmdGetDcDeviationReq Counter for ulEthercatMasterCmdGetDcDeviationReq
ulEthercatMasterCmdStartBusScanReq Counter for ulEthercatMasterCmdStartBusScanReq
ulEthercatMasterCmdBusScanInfoReq Counter for ulEthercatMasterCmdBusScanInfoReq

Table 40: Extended diagnosis > ECAT_MASTER > Packet counter stack
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8.4.3 Internal status stack

Figure 74: Extended diagnosis > ECAT_MASTER > Internal status stack

Name Description
Current state Current state of EtherCAT stack:

Possible values:
ETHERCAT_MASTER_NOT_INIT
ETHERCAT_MASTER_WAIT_FOR_BUSPARAM
ETHERCAT_MASTER_CONFIGURED
ETHERCAT_MASTER_WAIT_FOR_LINK
ETHERCAT_MASTER_RUNNING
ETHERCAT_MASTER_COMMUNICATING
ETHERCAT_MASTER_IDLE
ETHERCAT_MASTER_WATCHDOG_ERROR
ETHERCAT_MASTER_BUS_SCAN

Error during reset If an error occurred during reset, its error code is displayed here. In case of
successful reset, the value 0x0 is displayed here.

Link Status of link
Possible values:
· down
· up

Hard reset required A hard reset is required
Possible Values:
· no
· yes

Table 41: Extended diagnosis > ECAT_MASTER > Internal status stack
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8.5 ECAT_MASTER_AP

8.5.1 Packet counter AP task

Figure 75: Extended diagnosis > ECAT_MASTER_AP > Packet counter AP task

Name Description
ulDiagInfoGetCommonStateReq Counter for ulDiagInfoGetCommonStateReq
ulDiagInfoGetWatchdogTimeReq Counter for ulDiagInfoGetWatchdogTimeReq
ulDiagInfoSetWatchdogTimeReq Counter for ulDiagInfoSetWatchdogTimeReq
ulRcxGetSlaveHandleReq Counter for ulRcxGetSlaveHandleReq
ulRcxGetSlaveHandleCnf Counter for ulRcxGetSlaveHandleCnf
ulRcxGetSlaveConnInfoReq Counter for ulRcxGetSlaveConnInfoReq
ulRcxGetSlaveConnInfoCnf Counter for ulRcxGetSlaveConnInfoCnf
ulUnknownCommandReq Counter for ulUnknownCommandReq
ulEthercatMasterCmdSetBusparamReq Counter for ulEthercatMasterCmdSetBusparamReq
ulEthercatMasterCmdSetBusparamCnf Counter for ulEthercatMasterCmdSetBusparamCnf
ulEthercatMasterCmdBusOnCnf Counter for ulEthercatMasterCmdBusOnCnf
ulEthercatMasterCmdBusOffCnf Counter for ulEthercatMasterCmdBusOffCnf
ulEthercatMasterCmdUpdateCommunicationStateInd Counter for

ulEthercatMasterCmdUpdateCommunicationStateInd
ulEthercatMasterCmdUpdateGlobalSlaveInfoInd Counter for

ulEthercatMasterCmdUpdateGlobalSlaveInfoInd
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Name Description
ulConfigurationReloadReq Counter for ulConfigurationReloadReq
ulConfigurationReloadCnf Counter for ulConfigurationReloadCnf
ulEthercatMasterApCmdHostWdgTimeoutReq Counter for ulEthercatMasterApCmdHostWdgTimeoutReq
ulEthercatMasterCmdHostWdgTimeoutCnf Counter for ulEthercatMasterCmdHostWdgTimeoutCnf
ulEthercatMasterCmdRegisterAtStackCnf Counter for ulEthercatMasterCmdRegisterAtStackCnf
ulEthercatMasterCmdSdoUploadReq Counter for ulEthercatMasterCmdSdoUploadReq
ulEthercatMasterCmdSdoDownloadReq Counter for ulEthercatMasterCmdSdoDownloadReq
ulEthercatMasterCmdGetOdListReq Counter for ulEthercatMasterCmdGetOdListReq
ulEthercatMasterCmdGetObjectDescReq Counter for ulEthercatMasterCmdGetObjectDescReq
ulEthercatMasterCmdGetEntryDescReq Counter for ulEthercatMasterCmdGetEntryDescReq
ulEthercatMasterCmdReadEmergencyReq Counter for ulEthercatMasterCmdReadEmergencyReq
ulEthercatMasterCmdGetDcDeviationReq Counter for ulEthercatMasterCmdGetDcDeviationReq
ulEthercatMasterCmdStartBusScanReq Counter for ulEthercatMasterCmdStartBusScanReq
ulEthercatMasterCmdBusScanInfoReq Counter for ulEthercatMasterCmdBusScanInfoReq
ulRcxStartStopCommReq Counter for ulRcxStartStopCommReq

Table 42: Extended diagnosis > ECAT_MASTER_AP > Packet counter AP task
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8.5.2 DPM statistics

Figure 76: Extended diagnosis > ECAT_MASTER_AP > DPM statistics

Name Description
cyclic input data exchange requested counter Counter for requested cyclic input data exchanges
cyclic output data exchange requested counter Counter for requested cyclic output data exchanges
cyclic input data exchange executed counter Counter for executed cyclic input data exchanges
cyclic output data exchange executed counter Counter for executed cyclic output data exchanges
size of input process image Size of input process image
size of output process image Size of output process image

Table 43: Extended diagnosis > ECAT_MASTER_AP > DPM statistics
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8.5.3 Internal status of AP task

Figure 77: Extended diagnosis > ECAT_MASTER_AP > Internal status of AP task

Name Description
hard reset required A hard reset is required

Possible values:
· no
· yes
Table 44: Extended diagnosis > ECAT_MASTER_AP > Internal status of AP task
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9 Tools

9.1 Overview tools
Under "Tools", the Packet monitor and the IO monitor are provided for test
and diagnosis purposes.
· In the "Packet Monitor", data packets are used to communicate with the

firmware and are exchanged between the application (configuration
software) and the firmware in the device.

· The "I/O Monitor" offers an easy way to display data of the process
image and to change the output data.

Figure 78: Navigation area - Tools (example)

Online connection to the device

Note:
Accessing the Tools dialog panes of the EtherCAT Master DTM
requires an online connection from the EtherCAT Master DTM to
the EtherCAT Master device. For further information refer to section
Connecting/disconnecting device [} page 84].
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9.2 Packet monitor
The Packet monitor serves for test and diagnosis purposes.

Data packets, i. e. messages are self-contained blocks of defined data
length. The packets are used to communicate with the firmware and they
are exchanged between the application (configuration software) and the
firmware in the device. Packets can be sent once or cyclically to the
connected device controlled by the user and packets received can be
displayed.

Data packets comprise from a Packet header and the Send data or from a
Packet header and the Receive data. The packet header can be
evaluated by the receiver of the packet and contain the sender and receiver
address, the data length, an ID number, status and error messages and the
command or response code. The minimum packet size amounts 40 Byte
for the packet header. The sending and receiving data is added.

For further information to the packet description, refer to the
Protocol API Manual.

Ø Open the Packet monitor via Tools > Packet monitor.

Figure 79: Packet monitor

Display mode switches the representation of the send and reception data
between decimal and hexadecimal.
Ø Select Reset counter to reset the packet counter.
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9.2.1 Sending packet

Figure 80: Send > Packet header and Send data

Packet header

Under Send > Packet header the elements of the packet header of the
sending packet are displayed, which is transmitted from the application
(configuration software) to the device. The packet header of the sending
packets contain the elements described in the following table.

Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the

firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in bytes) Length of the send respectively receive data.
ID Packet Identification 

As Unique Number
Identifies identical data packets among each other.

State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 45: Descriptions Packet header

Ø Under Dest select the receiver (destination task queue).
Ø Under Cmd select the command identification (Request).

Auto Increment ID is an increment for the identifier of the data packets
and increments the ID by 1 for each newly sent packet.

Send data
Ø Under Send > Send data enter the send data of the packet, which shall

be transmitted from the application (configuration software) to the
mailbox of the device. The meaning of the transmitted data depends on
the command or response code.

Sending packets once or cyclic
Ø To send packet "once", select Put packet.
Ø To send packet "cyclic", select Put cyclic.
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9.2.2 Receiving packet

Figure 81: Packet header and Receive data

Packet header

Under Receive > Packet header the elements of the packet header of the
receiving packet are displayed, which are transmitted back from the device
to the application (configuration software). The packet header of the
receiving packets contain the elements described in the following table.

Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest
ID

Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the
firmware to the application (configuration software).

Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in bytes) Length of the send respectively receive data.
ID Packet Identification 

As Unique Number
Identifies identical data packets among each other.

State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 46: Descriptions Packet header

Receive data

Under Receive > Receive data the receiving data of the packet, which is
transmitted back from the device to the application (configuration software)
is displayed.
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9.3 I/O monitor
The IO monitor serves for test and diagnosis purposes. It provides to view
data of the process data image and to change output data easily. The
display is always in a Byte manner.

Note:
Only change and write output data if you know that no plant
disturbances are caused by this. All output data written by the IO
monitor is transmitted at the bus and have effect on subordinate
drives, IO etc.

Figure 82: IO monitor

Columns switches the number of columns.

Display mode switches the representation of the input and output data
between decimal and hexadecimal.

Offset / Go moves the indication of the data to the entered offset value.
Ø Enter the output value and select Update.
ð The data of the process image are always displayed, even if these

bytes are not reserved by the configuration.
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9.4 Process image monitor
The Process image monitor pane lists the slave devices connected to the
master, as well as the configured modules or input or output signals of the
devices. This makes visible the fieldbus structure and the data structure of
the device’s input and output data transmitted at the bus. Furthermore, the
values of the signal data provided to the OPC server are displayed here.
Ø Open Tools > Process image monitor.

Figure 83: "Process image monitor" pane

Parameter Description Range of value/
value

Display mode Display of the values in the column Value in decimal or hexadecimal mode. Decimal (Default),
Hexadecimal

The tree shows the structure of the devices (1), modules (2) and the input data
(3) and output data (4).

Display when the input and output data is not completely read and analyzed.

Display when the input and output data is not valid.

Display when the input and output data is valid.

Type Device labeling provided by the hardware: 
Also description of the modules or input or output signals configured to the
device.

TAG Device name provided by the hardware (not changeable in the FDT container) or
symbolic name for the modules configured to the device or for the input or output
signals (changeable in the Configuration > Process data pane).

Value Display of the valid input and output data values.
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Parameter Description Range of value/
value

Last error Last occurred error (Description see appropriate Application Programming
Manual)

Table 47: Notes to the "Process image monitor" pane
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10.2 User rights
User-rights are set within the FDT-container. Depending on the level, the
configuration is accessible by the user or read-only.

To access the Settings, Configuration and Diagnosis panes of the
EtherCAT Master DTM you do not need special user rights. Also all users
can select the decimal or hexadecimal Display mode or sort table entries.

Note:
To edit, set or configure the parameters of the Settings and
Configuration panes, you need user rights for "Maintenance", for
"Planning Engineer" or for "Administrator".

The following tables give an overview of the user right groups and which
user rights you need to configure the single parameters.

10.2.1 Settings
Settings Observer Operator Maintenanc

e
Planning
engineer

Adminis-
trator

Driver Verifying or adapting driver
settings [} page 22]

D D X X X

Configuring netX
driver [} page 25]

D D X X X

Device
Assignme
nt

Scanning for devices [} page 31] D D X X X
Selecting the device (with or
without firmware) [} page 34]

D D X X X

Selecting the device once more
(with firmware) [} page 34]

D D X X X

Selecting and downloading
firmware [} page 36]

D D X X X

Licen-
sing

Licensing [} page 42] D D X X X

Table 48: User rights settings (D = displaying, X = editing, configuring)

10.2.2 Configuration
Observer Operator Maintenanc

e
Planning
engineer

Adminis-
trator

General [} page 57] D D X X X
Process data handshake [} page 60] D D X X X
Topology [} page 60] D D X X X
Mailbox [} page 67] D D X X X
FMMU/Sync Man [} page 74] D D X X X
Process data [} page 77] D D X X X
Address table [} page 79] D D X X X
Init commands [} page 81] D D X X X

Table 49: User rights configuration (D = displaying, X = editing, configuring)
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10.3 Object dictionary
The object dictionary is a special area for the storage of parameters,
application data and the PDO mapping, i.e. the mapping information
between process data and application data. The object dictionary
functionality is similar to the one defined in the CANopen standard in order
to use CANopen-based device and application profiles in EtherCAT.
Access to the object dictionary is possible via Service Data Objects (SDO),
which provide a mailbox-based access functionality.

All CANopen-related data objects are contained in the object dictionary and
can be accessed in a standardized manner. You can view the object
dictionary as a container for device parameter data structures.

The following SDO services are provided for maintaining the object
dictionary:
· SDO Upload
· SDO Download

10.3.1 General structure
The object dictionary is structured in separate areas. Each area has its own
range of permitted index values and its special purpose as defined in the
table below:

Index Range Area name Purpose
0x0000 – 0x0FFF Data Type Area Definition and description of data types.
0x1000 – 0x1FFF CoE Communication Area Definition of generally applicable variables (communication

objects for all devices as defined by CANopen standard DS
301).

0x2000 – 0x5FFF Manufacturer-specific Area Definition of manufacturer-specific variables
0x6000 – 0x9FFF Profile Area Definition of variables related to a specific profile
0xA000 – 0xFFFF Reserved Area This area is reserved for future use

Table 50: General structure of object dictionary

10.3.2 Objects
The following kinds of objects may be defined within the object directory:

Object code Object name
0002 DOMAIN
0005 DEFTYPE
0006 DEFSTRUCT
0007 VAR
0008 ARRAY
0009 RECORD

Table 51: Definition of objects
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10.3.3 Data types
Data types can be defined in the data type area of the object dictionary
using object DEFTYPE as follows:

Data type index Name
0001 BOOLEAN
0002 INTEGER8
0003 INTEGER16
0004 INTEGER32
0005 UNSIGNED8
0006 UNSIGNED16
0007 UNSIGNED32
0008 REAL32
0009 VISIBLE_STRING
000A OCTET_STRING
000B UNICODE_STRING
000C TIME_OF_DAY
000D TIME_DIFFERENCE
000E Reserved
000F DOMAIN
0010 INTEGER24
0011 REAL64
0012 INTEGER40
0013 INTEGER48
0014 INTEGER56
0015 INTEGER64
0016 UNSIGNED24
0017 Reserved
0018 UNSIGNED40
0019 UNSIGNED48
001A UNSIGNED56
001B UNSIGNED64
001C-001F Reserved for future use

Table 52: Available data type definitions – part 1
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Data type index Name Object
0020 Reserved
0021 PDO_MAPPING DEFSTRUCT
0022 Reserved
0023 IDENTITY DEFSTRUCT
0024 Reserved
0025 COMMAND_PAR DEFSTRUCT
0026 IP_PAR DEFTYPE
0027-003F Reserved
0040-005F Manufacturer Specific Complex Data Types DEFSTRUCT
0060-007F Device Profile 0 Specific Standard Data Types DEFTYPE
0080-009F Device Profile 0 Specific Complex Data Types DEFSTRUCT
00A0-00BF Device Profile 1 Specific Standard Data Types DEFTYPE
00C0-00DF Device Profile 1 Specific Complex Data Types DEFSTRUCT
00E0-00FF Device Profile 2 Specific Standard Data Types DEFTYPE
0100-011F Device Profile 2 Specific Complex Data Types DEFSTRUCT
0120-013F Device Profile 3 Specific Standard Data Types DEFTYPE
0140-015F Device Profile 3 Specific Complex Data Types DEFSTRUCT
0160-017F Device Profile 4 Specific Standard Data Types DEFTYPE
0180-019F Device Profile 4 Specific Complex Data Types DEFSTRUCT
01A0-01BF Device Profile 5 Specific Standard Data Types DEFTYPE
01C0-01DF Device Profile 5 Specific Complex Data Types DEFSTRUCT
01E0-01FF Device Profile 6 Specific Standard Data Types DEFTYPE
0100-021F Device Profile 6 Specific Complex Data Types DEFSTRUCT
0220-023F Device Profile 7 Specific Standard Data Types DEFTYPE
0240-025F Device Profile 7 Specific Complex Data Types DEFSTRUCT
0260-0FFF Reserved Reserved

Table 53: Available data type definitions – part 2
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10.3.4 The CoE communication area
The CoE communication area is structured according to the definitions in
this table:

CoE communication area
Data Type Index Object Name Type M/O/C
1000 VAR Device type [} page 128] UNSIGNED32 M
1001 Reserved
:::: :::: :::: ::::
1007 Reserved
1008 VAR Manufacturer device name [} page 128] String O
1009 VAR Manufacturer hardware

version [} page 128]
String O

100A VAR Manufacturer software
version [} page 128]

String O

100B Reserved
:::: :::: :::: :::: ::::
1017 Reserved
1018 RECORD Identity object [} page 129] Identity (23h) M
101A Reserved
:::: :::: :::: :::: ::::

Table 54: CoE communication area - general overview

For index values larger than 0x1100 refer to the EtherCAT specification.

The sections below show for the single items of the CoE communication
area the following information:
· Name
· Object code
· Data type
· Category (Mandatory or optional)
· Access (Read-only or Read/Write)
· PDO mapping (Yes/No)
· Allowed values
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10.3.4.1 Device type
Index 0x1000
Name Device Type
Object code VAR
Data type UNSIGNED32
Category Mandatory
Access Read only
PDO mapping No
Value Bit 0-15: contain the used device profile or the value

0x0000 if no standardized device is used
Table 55: CoE communication area - device type

10.3.4.2 Manufacturer device name
Index 0x1008
Name Manufacturer Device Name
Object code VAR
Data type VISIBLE_STRING
Category Optional
Access Read only
PDO mapping No
Value Name of the device (specified as non zero terminated

string)
Table 56: CoE communication area - manufacturer device name

10.3.4.3 Manufacturer hardware version
Index 0x1009
Name Manufacturer Hardware Version
Object code VAR
Data type VISIBLE_STRING
Category Optional
Access Read only
PDO mapping No
Value Hardware version of the device (specified as non zero

terminated string)
Table 57: CoE communication area - manufacturer hardware version

10.3.4.4 Manufacturer software version
Index 0x100A
Name Manufacturer Software Version
Object code VAR
Data type VISIBLE_STRING
Category Optional
Access Read only
PDO mapping No
Value Software version of the device (specified as non zero

terminated string)
Table 58: CoE communication area - manufacturer software version
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10.3.4.5 Identity object
Index 0x1018
Name Identity Object
Object code RECORD
Data type IDENTITY
Category Mandatory

Table 59: CoE communication area – identity object

Number of entries
Index 0
Description Number of entries
Data type UNSIGNED8
Entry Category Mandatory
Access Read only
PDO mapping No
Value 4

Table 60: CoE communication area – identity object - number of entries

Vendor ID
Index 1
Description Vendor ID
Data type UNSIGNED32
Entry Category Mandatory
Access Read only
PDO mapping No
Value Vendor ID assigned by the CiA organization

Table 61: CoE communication area – identity object - vendor ID

Product code
Index 2
Description Product Code
Data type UNSIGNED32
Entry Category Mandatory
Access Read only
PDO mapping No
Value Product code of the device

Table 62: CoE communication area – identity object - product code

Revision number
Index 3
Description Revision Number
Data type UNSIGNED32
Entry Category Mandatory
Access Read only
PDO mapping No
Value Bit 0-15: Minor Revision Number of the device

Bit 16-31: Major Revision Number of the device
Table 63: CoE communication area – identity object - revision number
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Serial number
Index 4
Description Serial Number
Data type UNSIGNED32
Entry Category Mandatory
Access Read only
PDO mapping No
Value Serial Number of the device

Table 64: CoE communication area – identity object - serial number
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10.4 EtherCAT terminology
The following table lists essential EtherCAT terminology required in this
manual as well as descriptions of some common terms used for EtherCAT.

Term Description
CoE CANopen over EtherCAT

CoE designates a method for accessing the object dictionary, which was largely adopted from
CANopen for use in EtherCAT.

DC Distributed Clocks
E-Bus Bus system based on the LVDS standard
EtherCAT Master A device which is responsible for the configuration, parameterization of the EtherCAT segment,

all connected devices’ controllers, and cyclic process data exchange, mailbox and diagnostics
services.

EtherCAT port Physical type of data transfer used by EtherCAT. An EtherCAT slave controller can have up to 4
EtherCAT ports. These can be one of the following 3 alternatives:
· E-Bus
· 100Base-TX
· 100Base-FX

EtherCAT Slave A device which is configured by the Master, receives telegrams with output data, commands
from it and provides input and status data.

FMMU Fieldbus Memory Management Unit
A field bus memory management unit organizes a mapping of EtherCAT logical addresses to
physical addresses.

LVDS Low Voltage Differential Signals
A data transmission standard specified in ANSI/TIA/EIA-644-1995 and used in Beckhoff’s E-
Bus.

Object dictionary An object dictionary is a storage area for device parameter data structures containing device
descriptions. The object dictionary of EtherCAT is accessed in standardized manner very
similarly as this is done in CANopen. It is done via an index (16 bit, value range 0...65535) for
selecting the object and a sub-index (8 bit, value range 0...255), for selecting the sub-object
within the object.

State EtherCAT Master devices can be described by a state machine. The status of an EtherCAT
Master device corresponds to its current state. There are the following states:
• Init
• Pre-Operational
• Safe-Operational
• Operational
Only in the "Operational" state, the full functionality is available.

Sync Manager Synchronization Manager
A sync manager synchronizes the data communication on a specific communication channel. It
is configured for managing either input or output and for working either cyclically or acyclically
based on mailboxes. Configuration is done within the DDF file. Up to 4 sync managers,
numbered 0 to 3 can be configured.

Topology The topology of a network describes which nodes are connected in which way with other nodes
of the network. In the EtherCAT Master DTM the network topology can be displayed in two
ways:
· as tree view
· as Connection View

XML Extensible Markup Language
A versatile data storage format defined by the World Wide Web Consortium (W3C). It is based
on elements and attributes. In EtherCAT, it is used in device descriptions stored in DDF files.
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Term Description
Time synchronization A method that is used in an EtherCAT network to have events in the master and the slaves

occur as precisely as possible at the same time and to carry out high-precision time
measurements.
For this purpose it uses distributed clocks in the master and in the slaves (DC = Distributed
Clocks). An internationally standardized procedure for time synchronization is defined in the
IEEE 1588 standard. However, this standard is used by EtherCAT only for coupling external
clocks. The proper EtherCAT time synchronization procedure is based on IEEE 1588 in some
points, but also deviates from it in some points.
Time synchronization is particularly important for drive technology.

Table 65: EtherCAT terminology

10.5 Conventions in this document

Instructions
1. Operation purpose
2. Operation purpose

Ø Instruction

Results

 Intermediate result

 Final result

Signs

Sign Note
General note

Important note that must be followed to prevent malfunctions.

Reference to further information

Table 66: Signs

Signal words
Signal
word

Description

DANGER Indicates a hazardous situation, which if not avoided, will result in death or
serious injury.

WARNING Indicates a hazardous situation, which if not avoided, could result in death or
serious injury.

CAUTION Indicates a hazardous situation, which if not avoided, may result in minor or
moderate Injury.

NOTICE Indicates a property damage message.
Table 67: Signal words
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10.6 Legal notes

Copyright

© Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. Illustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft für Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.
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Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft für Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with
· Flight control systems in aviation and aerospace;
· Nuclear fission processes in nuclear power plants;
· Medical devices used for life support and
· Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:
· For military purposes or in weaponry;
· For designing, engineering, maintaining or operating nuclear systems;
· In flight safety systems, aviation and flight telecommunications systems;
· In life-support systems;
· In systems in which any malfunction in the hardware and/or software

may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).
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The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.
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Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
für Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft für
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft für Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.
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10.7 Registered trademarks
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1
and Windows® 10 are registered trademarks of the Microsoft Corporation.

EtherCAT® is a registered trademark and patented technology, licensed by
Beckhoff Automation GmbH, Germany.

CODESYS® is a registered trademark of 3S-Smart Software Solutions
GmbH, Germany.

All other brands mentioned are property of their respective owner of the
rights. Any company names and product designations provided in this
document may be brands (company names or trademarks) of the
corresponding owner and may be protected under trademark or patent law.
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Glossary
CODESYS COntroller DEvelopment SYStem: Development environment for

programming controller applications (PLC) according to the
international industrial standard IEC 61131-3

Data packet Data packets, i. e. messages are self-contained blocks of defined
data length. The packets are used to communicate with the firmware
and they are exchanged between the application (configuration
software) and the firmware in the device.

DDF Device Description File: A file containing configuration information
about a device being a part of a network that can be read out by
masters for system configuration. Device Description Files use
various formats which depend on the communication system. Often
these formats are based on XML such as EDS_files or GSDML_files.

DTM Device Type Manager: Software module with graphical user interface
for the configuration and/or for diagnosis of devices

EtherCAT Ethernet for Control Automation Technology: communication system
for Industrial Ethernet designed and developed by Beckhoff
Automation GmbH, Verl, Germany

EtherCAT Master Device responsible for configuration and parameterization of: an
EtherCAT segment, the controllers of all devices within this segment
and all services for cyclic process data exchange, mailbox operation
and diagnosis

EtherCAT Slave Device which is configured by the EtherCAT master, receives data
telegrams containing output data, executes commands issued by the
EtherCAT master and provides input and status data

Ethernet Network technology used both for office and industrial communication
via electrical or optical connections. It has been developed and
specified by the Intel, DEC and XEROX, provides data transmission
with collision control and allows various protocols. As Ethernet is not
necessarily capable for real-time application, various real-time
extensions have been developed (industrial Ethernet, real-time
Ethernet).

FDT Field Device Tool: FDT specifies an interface, in order to be able to
use DTM (Device Type Manager) in different applications of different
manufacturers

IP Internet Protocol: Belongs to the TCP/IP family of protocols and is
defined in RFC791 (available on http://www.ietf.org/rfc/rfc791.txt). It is
based on layer 3 of the ISO/OSI 7 layer model of networking and is a
connectionless protocol, i. e. you do not need to open a connection to
a computer before sending an IP data packet to it. Therefore, IP is not
able to guarantee that the IP data packets really arrive at the
recipient. On IP level, neither the correctness of data nor the
consistence and completeness are checked. IP defines special
addressing mechanisms; see IP address.
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IP address Identifies a device or a computer within an IP-based network and is
defined in the Internet Protocol Version 4 (IPv4) as a 32-bit number.
For ease of notation, the address is usually divided into four 8-bit
numbers represented in decimal notation and separated by points:
a.b.c.d. Each letter stands for an integer value between 0 and 255,
e.g. 192.168.30.16. However, not all combinations are allowed, some
are reserved for special purposes. The IP address 0.0.0.0 is defined
as invalid.

Master Type of device that initiates and controls the communication on the
bus

Module Hardware or logical component of a physical device

netX networX on chip, Hilscher network communication controller. High
integrated network controller with optimized system architecture for
communication and maximum data transfer.

ODMV3 Online-Data-Manager Version 3: Application interface, respectively
works as a server, which can be run as an out-proc server or system
service. Its task is to provide different applications (e. g. SYCON.net),
access to multiple devices and even share one device amongst
several applications.

PDO Process Data Object: Specific data object for cyclic data
communication

SCADA Supervisory Control and Data Acquisition: A concept for the control
and data acquisition of technical processes

SDO Service Data Object: Specific data object for acyclic data
communication, i.e. mailbox-based communication. It is typically used
for accessing the object dictionary.

Slave Type of device that is configured by the master and which then
performs the communication

Submodule Hardware or logical component of a physical device.

SYCON.net Multiprotocol-capable Hilscher configuration and diagnosis software
(FDT frame application), that can be used to configure
communication-capable fieldbus devices of different manufacturers in
one project

TCP/IP Transport Control Protocol/Internet Protocol connection-orientated,
secure transfer protocol as basis for the Internet-protocols

USB Universal Serial Bus

XML Extended Markup Language: symbolic language for structuring data
systematically which is maintained as a standard by the W3C (World-
wide web consortium). Device Description Files often use XML-based
formats for storing the device-related data appropriately.
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